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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-

ROM IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE 

TERMS OF THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]). 

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO 

NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN 

THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 

30 DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A 

REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and 

conditions of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single 

computer. You may physically transfer the SOFTWARE from one computer to another 

provided that the SOFTWARE is used on only one computer at a time. You shall not install 

or use the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other 

hardware configuration where the SOFTWARE is accessible to more than one CPU or to 

more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE 

USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING 

LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE 

OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, 

or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your 

computer and retain the original for back-up purposes. Any other copying of the 

SOFTWARE is a violation of this Agreement. You must reproduce and include the copyright 

notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support 

for use of the SOFTWARE. No updates, fixes or support will be made available for the 

SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, 

maintain and match the hardware and software components of your computer system. Thus 

Canon does not guarantee uninterrupted service or correction of errors or that the functions 

or performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS 

LICENSED ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-

ROM storing the SOFTWARE is warranted only against defective material under normal use 

for a period of ninety (90) days after purchase from an authorized Canon dealer as 

evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be 

replacement of the same without charge when returned by you at your expense to your 

point of purchase and proven to be defective upon inspection. The replacement CD-ROM 

will be warranted for the remainder of the original ninety (90) day warranty period of the 

defective CD-ROM. The limited warranty does not apply if the failure of the CD-ROM 

resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to 

anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S 

SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS 

OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.
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NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 

IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT 

LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING 

LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR 

ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 

SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT 

BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF 

INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect 

until expiration of all copyright interests in the SOFTWARE unless earlier terminated. You 

may terminate this Agreement by destroying the SOFTWARE. This Agreement will also 

terminate without notice to you if you fail to comply with any of the terms of this Agreement 

and you must then promptly return the SOFTWARE. In addition, Canon may enforce its 

other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with 

restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either 

subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at 

DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer 

Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be 

illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void 

with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this 

Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the 

Software in the United States of America shall be governed and construed in all respects in 

accordance with the laws and regulations of the State of New York, without reference to 

choice of law principles. The terms of this Agreement as it relates to purchases of the 

Software in Canada shall be governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 

SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use 

of the SOFTWARE is subject to the United States, Canada and other applicable copyright 

and trademark laws and nothing in this Agreement constitutes a waiver of the rights of 

Canon, its affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in 

any images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU 

HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS 

TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE 

COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND 

CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL 

PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER 

COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER 

HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS 

SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
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Manual Organization, How to Read the Manual and the Conventions Used
 This manual consists of a chapter for Windows followed by a chapter for Macintosh.

 In this manual, Windows XP Professional/Home Edition is referred to as Windows XP, 

Windows Millennium Edition is referred to as Windows Me, Windows 2000 Professional is 

referred to as Windows 2000, and Windows 98 Second Edition is referred to as Windows 98 

SE.

 Where explanations are common to all operating systems, the screens used in the 

examples are from Windows XP for Windows and from Mac OS X (10.2) for Macintosh.

 In this document, square brackets [ ] are used to indicate items such as button names and 

icon names that appear on the computer screen.

 Numbers in parentheses in this document indicate reference pages.

 Descriptions of camera operations assume that the reader is familiar with the information in 

the camera’s Instruction Manual.

 For the restrictions that apply to the software products, refer also to the Readme files for the 

respective products.

 In order to transfer images from EOS Viewer Utility, you will need retouching (image editing) 

software. In order to start the TWAIN Driver, you will need a TWAIN Driver-compatible 

application. Explanations for transferring images from EOS Viewer Utility described in these 

instructions and the explanations for TWAIN Driver-compatible applications all use 

examples from Adobe Photoshop 7.0.

 The explanations given below describe the type of content indicated by the respective icons.

 : Marks information that should be read before use to prevent problems that would 

interfere with the functioning of software and computer.

 : Marks additional information that you will find helpful.

Please read the safety precautions carefully before using this product. Ensure that you use the 

product correctly according to the procedures described in these instructions.

The following safety precautions are intended to instruct you in the safe and correct operation 

of the product and its accessories to prevent injuries or damage to yourself, other persons and 

property. Please read and ensure that you understand them before you proceed to the other 

sections of these instructions.

 Warning

Do not play the supplied CD-ROM(s) in any CD-ROM Player that does not support data CD-ROMs. The 

extremely loud sound that may result from playing the CD-ROM(s) in an audio CD player (music player) 

could damage the speakers. It is also possible to suffer hearing losses from listening with headphones to 

the loud sounds of a data CD-ROM played on a music CD player.

Safety Precautions
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Software
This section briefly describes the main functions of the software provided on the bundled CD-

ROM.

 EOS DIGITAL Solution Disk

 PhotoStitch creates composite images such as panorama shots by merging multiple 

images.

 WIA Driver or TWAIN Driver controls the communication between the camera and EOS 

Viewer Utility. To use EOS Viewer Utility, you must install the WIA Driver for Windows XP or 

Me, and install the TWAIN Driver for Windows 2000, 98 SE.

 Also used for downloading JPEG images to your computer if you use the WIA Driver alone, 

or use the TWAIN Driver with a TWAIN Driver-compatible application, without using EOS 

Viewer Utility.

 Dedicated software for an EOS DIGITAL 

camera to be used for downloading and 

displaying images, processing RAW 

images, specifying the camera settings 

such as personal functions, and remote 

shooting.

 Can be used for downloading images 

saved on the memory card in the camera 

to your computer, displaying single-

frame or thumbnail images, checking 

shooting information or histograms.

 Capable of rotating, protecting, and 

saving images, playing sound, printing 

image indexes, and transferring images 

to the retouching software.

 Can be used for displaying RAW images and specifying various processing parameters.

 Supports the color management system.

 Supports the color space of sRGB and Adobe RGB.

 Can be used for specifying the personal functions and processing parameters on the 

camera.

 Enables you to control the camera from your computer using the remote shooting function 

(EOS Capture) to shoot single-frame images or images using the timer or interval timer. 

Also, allows you to download images directly to your computer.

EOS Viewer Utility/EOS Capture       

PhotoStitch       

WIA Driver/TWAIN Driver      
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 In addition, you can use the WIA Driver or TWAIN Driver (W-97) to quickly and easily 

download JPEG images from your camera. You can also use PhotoStitch to merge multiple 

images to create a panorama shot easily.

Trademark Acknowledgments

 Canon and EOS are trademarks of Canon Inc.

 Adobe and Photoshop are registered trademarks or trademarks of Adobe Systems 

Incorporated in the United States and/or other countries.

 IBM is a registered trademark of International Business Machines Corporation.

 Microsoft and Windows are registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries.

 iBook, iMac and QuickTime are trademarks of Apple Computer Inc.

 Macintosh, PowerBook, Power Macintosh and FireWire are trademarks of Apple 

Computer Inc., registered in the United States and other countries.

 Other names and products not mentioned above may be registered trademarks or 

trademarks of their respective companies.

Operation Flow

Install the software (W-4, M-4)

Start up EOS Viewer Utility (W-12, M-12)

Connect the camera to your computer (W-8, M-8)

To edit/display the 
images

Download the images

 to your computer

(W-16, M-16)

Edit/Display the images 

(W-20 to 44, M-20 to 44)

For remote shooting To specify the 

camera settings

Open the Remote 

Shooting window

(W-88, M-88)

Shoot remotely and

 download the images

(W-90, M-90)

Open the Camera 

Settings window

(W-56, M-56)

Specify the 

camera settings

(W-57 to 86, M-57 to 86)



1 Installing the Software .............................................................................. W-3

Describes how to install the bundled software.

2 Preparation for Downloading Images ...................................................... W-7

Explains how to connect the camera or a card reader (third-party product) to your 

computer, and complete the installation. 

3 Working with Images in EOS Viewer Utility .......................................... W-11

Explains how to use EOS Viewer Utility to download images to your computer, edit and 

save images, and transfer the downloaded images to the retouching software.

4 Specifying Camera Settings in EOS Viewer Utility............................... W-55

Describes how to specify the owner’s name and date/time, the Personal Functions, the 

Parameters, and the Personal White Balance in the camera.

5 Remote Shooting in EOS Viewer Utility................................................. W-87

Describes how to use the Remote Shooting function in EOS Viewer Utility for taking shots 

and specifying the camera settings remotely from your computer.

6 Downloading JPEG Images with the Driver .......................................... W-97

Describes how to download JPEG images using the WIA Drivers for Windows XP or 

Windows Me, and the TWAIN Drivers for Windows 2000 or Windows 98 SE.

7 Troubleshooting and Uninstallation .................................................... W-103

Provides a troubleshooting and describes the software uninstallation procedures.

Index ........................................................................................................................W-117

Where explanations are common to all operating systems, the screens used in the examples 

are from Windows XP.

W
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System Requirements
The software bundled with this product runs on the systems described below.

 Depending on your computer system, this software may not run correctly on Windows 98. 

Use the Windows 98 SE operating system or later.

 A CD-ROM drive is required for installation.

OS
Windows XP (Home Edition/Professional), Windows Me, 

Windows 2000, Windows 98 SE

Computer

PC with one of the above OS preinstalled and equipped with an 

IEEE1394 port

* Upgraded machines not supported.

CPU
Windows XP: 300 MHz Pentium or better

Windows Me, 2000, 98 SE: 150 MHz Pentium or better

RAM
Windows XP: Minimum 256 MB

Windows Me, 2000, 98 SE: Minimum 128 MB

Interface IEEE1394

Hard disk space

EOS Viewer Utility/EOS Capture: 300 MB or more

WIA Driver: 25 MB or more

TWAIN Driver: 25 MB or more

PhotoStitch: 40 MB or more

Display
Screen resolution: 1024 by 768 pixels or more

Color quality: Medium (16 bit) or more
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Installing the 

Software

This chapter describes how to install the bundled software.

If you were unable to successfully install the software using the procedure given in 

this manual, see “Troubleshooting” (W-104).

Installing the Software ............................................................................ W-4

Correct Installation Procedure .............................................................. W-4
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Installing the Software
 Check that your computer complies with the system requirements for the software (W-2) as 

you follow the installation procedure.

 Always install the software as described in the procedures below.

1 Start up your computer (step 1).

2 Install the software (steps 2 through 9).

3 Remove the CD (step 10).

4 Connect the camera to your computer and complete the installation (W-8).

 Never connect the camera to your computer before you install the software. The 

software will not be installed correctly. You must connect the camera to your computer 

after removing the CD.

 If you connected the camera to your computer before installing the software, see 

“Troubleshooting” (W-107).

1 Start up your computer.

 Exit any programs that are running.

2 Insert the CD (EOS DIGITAL Solution Disk).

 The Installer panel appears.

3 Click the [Install] button.

 The [Preparing to Install] window 

appears and after a brief wait, the 

[Welcome to the InstallShield 

Wizard for Solution Disk] window 

appears.

If the dialog box that prompts you to restart your computer appears, restart your 

computer. After the computer restarts, the software installation process continues 

automatically.

Correct Installation Procedure
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4 Click the [Next] button.

5 Select [Easy Installation] and click the [Next] button.

6 Check the details of the License Agreement and then click the 

[Yes] button.

7 Check the software and the folder in which the software will be 

installed, and then click the [Next] button.

 Installation begins. It will be 

complete in approx. 2 to 3 

minutes.
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8 Click the [Finish] button.

9 Click the [Exit] button.

10Remove the CD.

 Connect the camera to your 

computer and complete the 

installation referring to the 

procedures in Chapter 2.

If you were unable to successfully install the software using the procedure given in this 

manual, see “Troubleshooting” (W-104).
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Preparation for 

Downloading Images 

This chapter explains how to connect the camera or a card reader (third-

party product) to your computer, and complete the installation.

If you were unable to successfully install the software using the procedure given in 

this manual, see “Troubleshooting” (W-105).

Connecting the Camera to Your Computer........................................... W-8

Connecting the Camera to Your Computer for the First Time .............. W-8

Connecting the Camera to Your Computer the Second Time or Later ..... W-9

Using Your Card Reader ....................................................................... W-10
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Connecting the Camera to Your Computer
Before downloading images to your computer or specifying the camera settings, you must 

connect the camera to your computer with the dedicated IEEE1394 cable. 

You can connect the camera while your computer is running.

When you connect the camera to your computer for the first time to complete the installation, 

follow the procedure below right after performing “Installing the Software” (W-4).

1 Plug the dedicated cable into the computer.

 Plug the cable into the IEEE1394 

port.

 Refer to the computer User’s 

Manual for information on the 

terminal areas.

2 Plug the dedicated cable into your camera.

 Open the cover and plug the cable  

into the < > terminal. 

3 Set the camera’s power switch to <ON>.

 When the pop-up menu appears and then disappears automatically, the installation is 

complete.

Connecting the Camera to Your Computer 
for the First Time
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When you connect the camera to your computer the second time or later, follow the same 

procedure, set the camera’s power switch to <ON>, and then proceed to Chapter 3.

 For Windows 2000, Me, 98 SE, nothing appears when the installation is complete. 

However, if the [Found New Hardware] or [Building driver information database] 

dialog box appears, when the dialog box disappears automatically, the installation is 

complete.

 When the installation is complete, the camera is ready to communicate with your 

computer. Proceed to Chapter 3 continuously.

 Do not set the camera’s power switch to <OFF> until the pop-up menu and dialog 

boxes automatically disappear.

 If the dialog box that prompts you to restart your computer, restart your computer 

without fail.

 If you were unable to successfully install the software using the procedure given in 

this manual, see “Troubleshooting” (W-105).

The pop-up menu and dialog boxes shown in step 3 do not appear when you connect the 

camera to your computer the second time or later.

 Never perform the following operations while the software installed from the Solution 

Disk is running after connecting the camera to the computer as a communications 

error may occur.

• Set the camera’s power switch to <OFF>.

• Open the memory card slot cover.

• Disconnect the dedicated cable, remove the battery, and then remove the DC 

coupler.

• Disconnect the AC adapter’s plug or power cord.

Before you perform the operations above, be sure to exit all the software.

 Use only the dedicated IEEE1394 cable.

 Push the plug firmly all the way into the socket. Loose connections can cause faults 

or malfunctions.

 Do not connect the camera to your computer via a hub. Or do not connect multiple 

IEEE1394 devices to your computer. If you do so, the camera may not operate 

correctly.

 Operation of the Auto power off function will automatically switch the camera off, 

disabling to communicate with your computer. Set the Auto power off function to 

[OFF] in advance. (Refer to “Menu Operations” in the camera’s Instruction Manual.)

 Do not connect more than one camera to the same computer. The connections may 

not operate correctly.

Connecting the Camera to Your Computer 
the Second Time or Later
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Users with a third-party card reader can download images directly from a memory card to the 

computer.

 While the camera and your computer are communicating, the camera’s LCD panel 

may blink or the image on the monitor may flicker. However, this is not a malfunction.

 When unplugging the dedicated cable, be sure to grip the sides of the plug as you pull 

it out.

 If you do not perform any operation while the camera and computer are connected, a 

confirmation message appears on the computer screen asking whether you wish to 

continue communicating with the camera for some computer systems. If you do not 

perform any operation even after this message appears, the communication with the 

camera is terminated. To re-establish the communication, press the shutter button 

down halfway or set the camera’s power switch to <OFF> and then back to <ON>.

 Do not put your computer to sleep while it is connected to the camera. 

If your computer goes into the sleep mode, never disconnect the dedicated cable 

while your computer is still in the sleep mode. Always wake your computer up while it 

is connected to the camera. On some types of computer, disconnecting the dedicated 

IEEE1394 cable while your computer is in sleep mode could prevent the computer 

from waking up correctly. Refer to the computer User’s Manual for more information 

on sleep mode.

 When the camera is connected to a computer, you should use the DC Coupler Kit.

 If your computer has a 4-pin IEEE1394 port, use a Canon 4-pin to 4-pin IEEE1394 

cable (optional).

1 Remove the memory card from the camera.

2 Load the card into the card reader.

 Proceed to Chapter 3.

For information on connecting the card reader to your computer, refer to the card reader 

User’s Manual.

Using Your Card Reader
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Working with Images 

in EOS Viewer Utility

This chapter explains how to use EOS Viewer Utility to download images to 

your computer, edit and save images, and transfer the downloaded images 

to the retouching software.

For more information on the restrictions of EOS Viewer Utility, refer also to the source 

listed below.

Readme: Click the [Start] button � select [All Programs] ([Programs] in other 

versions of Windows) � [Canon Utilities] � [EOSViewerUtility xx] (“xx” is 

the version) � [EOSViewerUtility Readme].

Starting EOS Viewer Utility.......... W-12

Downloading Images ................... W-16

Handling the Folders.................... W-18

Memory Card Folder Structure and File 

Names ........................................ W-18

Registering Frequent Use Folder ...W-19

Selecting the Image Display Mode.. W-20

Main Window (Thumbnail Display) ....W-20

Preview Window Display ............ W-20

Selecting the Display Size .......... W-22

Checking the AF Point................ W-22

Selecting Images .......................... W-23

Selecting Images in the Main Window .. W-23

Selecting Images in the Preview 

Window....................................... W-23

Attaching Check Marks to Images .....W-24

Selecting Images by Condition ... W-24

Bringing/Sending the Main Window to 

the Front/Back of Window Stack..W-25

Equalizing the Display Sizes in the 

Preview Window ......................... W-25

Editing Images.............................. W-26

Protecting Images....................... W-26

Rotating Images ......................... W-26

Deleting Images.......................... W-27

Checking the Image Information and 

Entering Comments.................... W-27

Playing Back Sound..................... W-28

Printing Images ............................ W-28

Editing RAW Images .................... W-29

Processing RAW Images ........... W-29

Specifying the Processing Parameters ..W-30

Adjusting the Brightness (Digital 

Exposure Compensation)........... W-31

Adjusting the White Balance ...... W-32

Saving the White Balance .......... W-36

Adjusting the Color and Brightness 

(Adjust Tone Curve) ................... W-37

Selecting the Contrast ................ W-40

Selecting the Color Matrix .......... W-41

Adjusting the Color ..................... W-43

Selecting the Sharpness ............ W-44

Saving Images .............................. W-45

Transferring Images to Retouching 

Software ........................................ W-48

Specifying the Preferences ......... W-50

Setting the IPTC Information....... W-51

Merging Images with PhotoStitch...W-54



W-12

Starting EOS Viewer Utility

1 Connect the camera to your computer (W-8).

 The dialog box on which the 

camera model is displayed 

appears.

 Your camera model is displayed in 

EOS XXX.

 For Windows Me, the [Scanner 

and Camera Wizard] dialog box 

appears.

 Click the [Cancel] button to close 

the open window.

2 Click the [Start] button � select [All Programs] ([Programs] in 

other versions of Windows) � [Canon Utilities] �

[EOSViewerUtility xx] � [EOSViewerUtility].

 The main window appears.

 You can also start EOS Viewer Utility by double-clicking the [EOSViewerUtility] icon 

on the desktop.

 EOS Viewer Utility version information is displayed in xx.



Starting EOS Viewer Utility

W-13

W

3

W
o

rk
in

g
 w

it
h

 I
m

a
g

e
s
 i
n

 E
O

S
 V

ie
w

e
r 

U
ti
lit

y

Main window

* The above window shows all the information at once. In actual use, only the information 

needed is displayed.

 To exit EOS Viewer Utility, select the [File] menu � [Exit].

Main window tool bar Menu bar

Displays the [File], [Edit], [View], 
[Option], [Window], [Help] menus.

Histogram

Shows the distribution of 
the brightness of an image. 
Selecting the tab switches 
the histogram display 
values between Brightness 
and RGB.

Path display
Displays the connected 
camera, drive and folder on 
your computer.

Image display areaStatus bar Comment input box (W-27)

Bookmark area (W-19) 
Detailed Image information 
display area (W-27)

Folder Tree Area (W-16)

RGB value display

When you move the cursor over an image, the 
coordinates of the cursor position and its RGB 
values (8-bit conversion) are shown here.
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Main window tool bar

* The above window shows all the information at once. In actual use, only the information 

needed is displayed.

Folder Tree button

Shows/hides the Folder Tree Area.

Display Size list 
box (W-22)

Rotate right 90 degrees button (W-26)

Remove Check Mark button (W-24)

Remove protect button (W-26)

Transfer images button (W-48)

Protect button (W-26)

Erase images 
button (W-27)

Save File button (W-45)

Select images button (W-24)

Thumbnail Frames button
Shows/hides the information 
display frame of thumbnail 
images.

Add Check Mark button (W-24)

Rotate left 90 degrees button (W-26)

Show/Hide Image Information button

Shows/hides the histogram, image information display area, 
and comment input box.

Camera Settings button 
(W-56)

IPTC information button (W-51)

Play sound button (W-28)

Window button (W-25)
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RAW adjustment tool palette

 When you select a RAW image, the name of the camera on which the selected RAW image 

was taken and its settable processing parameters are displayed.

 If you select the [Advanced] tab, the [Advanced] tab sheet appears.

* The above tool palette shows all the information at once. In actual use, only the information 

needed is displayed.

In the RAW adjustment tool palette you cannot edit JPEG images, or TIFF and JPEG 

images that were converted from RAW images with EOS Viewer Utility.

 The settings used when shots were taken are listed in italic type in the list box.

 If the RAW adjustment tool palette is hidden, select the [View] menu � [Tool palette] 

to show it.

Camera type (W-30)
Displays the name of the camera on which the selected RAW images were taken.

Advanced tab sheet (W-43)

Digital Exposure 
Compensation slider (W-31)

Color Temp. input box (W-33)

White Balance list box 
(W-32, W-33)

LB Filter slider (W-35)

CC Filter slider (W-35)

Tone Curve button (W-37)

Standard tab sheet (W-41)

Contrast list box (W-40)

Preview checkbox (W-30)

Digital Exposure Compensation 
Value display box (W-31)

Save White Balance Settings button 
(W-36)

Click White Balance button (W-34)

LB Filter Compensation Value 
display box (W-35)

CC Filter Compensation Value 
display box (W-35)

Reset to Shot Settings button 
(W-30)

Color Matrix list box (W-41)

Color list box (W-43)

Color Space list box (W-43)

Sharpness list box (W-44)

Update button (W-30)

Color Tone list box (W-43)
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Downloading Images
The procedure below describes how to download (copy) the images saved on a memory card 

in the camera to your computer, and display them on the main window. You can download 

images in the Folder Tree Area.

1 Create a folder to which images will be downloaded.

 From the menu that is displayed 

by right-clicking on the destination 

folder, select [New folder] to 

create a folder and enter a name 

for the folder. (The [Photo] folder is 

created in the [My Pictures] folder 

here as an example.)

2 Display a folder to be copied.

 Double-click the camera icon �

the [1] folder (CF card) or the [2] 

folder (SD card) � the [DCIM] 

folder.

 The [xxxEOSXXX] folder is 

displayed.

3 Copy the folder to the hard disk.

 Drag and drop the [xxxEOSXXX] 

folder to the destination folder.

 The [xxxEOSXXX] folder is saved 

on your computer.

xxx: A number between 100 and 999 is displayed.
XXX: The camera model connected to your 

computer is displayed.



Downloading Images

W-17

W

3

W
o

rk
in

g
 w

it
h

 I
m

a
g

e
s
 i
n

 E
O

S
 V

ie
w

e
r 

U
ti
lit

y

Supported Image Formats
The following images can be displayed in EOS Viewer Utility.

• RAW and JPEG images shot on an EOS DIGITAL series (1D Mark II, 1Ds, 1D, 10D, D60, 

D30, DIGITAL REBEL/300D DIGITAL) camera

• TIFF and JPEG images saved in EOS Viewer Utility (W-45)

• DCF-compliant JPEG images

* Images that cannot be displayed appear as a question mark [?].

4 Click the copied folder.

 The images in the folder are 

displayed.

 Before disconnecting the camera 

from your computer, exit EOS 

Viewer Utility, set the camera’s 

power switch to <OFF>, and then 

disconnect the dedicated cable.

 You cannot display images in the preview window (W-20) or edit RAW images (W-29) 

saved on a memory card in the camera directly. Before working images with EOS 

Viewer Utility, be sure to download images saved on a memory card to your 

computer.

 For displaying images saved in a third-party card reader, follow the same procedure 

to download the target folder to your computer.

 The images that are processed on your computer after being shot or the images 

whose file name is changed may not be displayed properly.

 You cannot use the camera while displaying images on the camera.

 Images that were shot with the camera held vertically with [Auto rotate] setting to 

<ON> are automatically displayed vertically.

 If the selected folder contains a large number of images, there may be a short delay 

before the images appear.
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Handling the Folders
You can handle the folder on the menu that appears by right-clicking the folder.

The images are placed in the camera icon � the [1] folder (CF card) or the [2] folder (SD card) 

� the [DCIM] folder � the [xxxEOSXXX] folder. (“xxx” represents a number between 100 and 

999, and “EOSXXX” represents the camera model on which shots were taken.)

 The “****” in the file names represent the factory-set characters that are unique to each camera.

 The “YYYY” in file names represents four-digit numbers.

Right-click on the folder and select an option from the menu that 

appears.

You can drag and drop folders from the Folder Tree Area to the other folders.

For JPEG images that were shot with Adobe RGB setting, the first character shows “_” 

(under bar) according to Exif 2.21 regulations.

Opens the selected folder.

Creates a new folder. Note that you 
cannot create a new folder in the 
memory card in the camera.

Allows you to change the folder name.

Memory Card Folder Structure and File Names

xxxEOSXXX

****YYYY.JPG (JPEG images, 
sRGB set for color space of matrix)

_***YYYY.JPG (JPEG images, 
Adobe RGB set for color space of matrix)

****YYYY.CR2 (RAW images)

DCIM1

CANONMSC

MISC2

The folder that holds the image control files 
in the DCIM folder.

The folder created when DPOF settings are set.
It folds the DPOF settings files.
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You can register frequent use folders as bookmark folders.

1 Display a folder to be registered (W-16).

2 Register a folder as a bookmark folder.

 Drag and drop the folder to be 

registered as shown on the right.

 The folder icon appears in the 

Bookmark area when it is 

registered.

 To delete the registered folder, 

right-click the folder and select 

[Delete] from the menu that 

appears.

 You can also reorder the folders in the Bookmark area by dragging and dropping 

them.

 When you delete the registered folder, it just disappears from the Bookmark area. 

The actual data of the folder and the images in that folder will not be deleted.

Registering Frequent Use Folder
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Selecting the Image Display Mode
You can select the display size and method of images.  

Various information can be displayed with images.

Double-clicking an image displayed on the main window can enlarge the image. 

When you change the processing parameters of RAW images, use this window.

 Up to six images can be displayed in the preview window at a time.

 A low resolution image is displayed first in the preview window, and then it changes to a high 

resolution image.

Preview window

Main Window (Thumbnail Display)

Digital exposure 
compensation value (W-31)

Protect mark (W-26)

This mark is displayed on 
protected images.

Recording quality

The [RAW] and [RAW+JPEG] 
symbols are displayed for RAW and 
RAW+JPEG images respectively. No 
symbol is displayed for JPEG images.

File name or shooting date/
time

The items selected in the 
[Image Lower Display Item] list 
box in the [General Settings] 
dialog box (W-50) are 
displayed.

Sound recording mark (W-28)

This mark is displayed on images 
for which sound was recorded.

Check mark (W-24)

This mark is displayed on images for 
which a check mark was attached.

Preview Window Display

Preview tool bar
RAW adjustment tool palette
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Preview tool bar

* The above window shows all the information at once. In actual use, only the information 

needed is displayed.

You cannot display images in the preview window or edit RAW images (W-29) saved on 

a memory card in the camera directly. Before working images with EOS Viewer Utility, be 

sure to download images saved on a memory card to your computer.

For some images, it may take some time to change to the high resolution image.

Display Size list box (W-22)

Show Next Image 
button (W-23)

Rotate left 90 degrees button (W-26)

Remove Check Mark button (W-24)

Remove protect button (W-26)

Save File button (W-45)

Erase images 
button (W-27)

Transfer images button 
(W-48)

Protect button (W-26)

Add Check Mark button (W-24)

Rotate right 90 degrees button (W-26)

Show Previous 
Image button 
(W-23)

Show/Hide Image Information button

Show/hides the histogram, image 
information display area, and comment 
input box.

AF point button (W-22)

IPTC information button (W-51)

Window button (W-25)

Play sound button (W-28)
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The AF point used when the shot was taken can be displayed.

Select a display size from the list box.

 In the main window, the available 

image sizes are [Small] (64  64 

pixels), [Medium] (100  100 

pixels), and [Large] (160  160 

pixels).

 In the preview window, the 

available image sizes are [Fit to 

window] and [100%].

 When you select [100%], you can 

change the display position by 

dragging the image.

1 Display the image in the preview window (W-20).

2 Click the [AF point] button.

 The AF point is displayed.

 Clicking the button again hides the 

AF point.

When the shot was taken with automatic AF point selection, multiple active AF points 

might be displayed.

Selecting the Display Size

Main window

Preview window

Checking the AF Point
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Selecting Images

Click the target image.

 The frame around the selected 

image is colored.

 To select multiple images, hold 

down the <Ctrl> key and click the 

images.

 To select sequential images, click 

the first image and then hold down 

the <Shift> key and click the last 

image.

Alternatively, you can use the arrow keys (����) on the keyboard to select images. 

Click the target image.

 The selected image is displayed 

on the top window.

 When only one preview window is 

displayed, you can click the [Show 

Previous Image] button or the 

[Show Next Image] button to 

select the image to be displayed.

Selecting Images in the Main Window

Selecting Images in the Preview Window
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You can attach a check mark to the RAW image, allowing you to select images more easily.

This feature allows you to select multiple images in a single operation using conditions.

Click the [Add Check Mark] button.

 When the check mark is placed, 

the [ ] icon appears in the frame 

of the image.

 Clicking the [Remove Check Mark] 

button removes the [ ] icon from 

the frame of the image, and 

erases the check mark.

You cannot attach the check mark for any images other than RAW images.

 When multiple RAW images are selected, the check mark is attached to all the 

selected RAW images.

 Alternatively, you can perform the same operation using the menu that appears by 

right-clicking.

Click the [Select images] button and select the condition from the 

menu that appears.

 Only images that meet the 

condition are selected.

Attaching Check Marks to Images

Selecting Images by Condition
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You can set all the preview windows to the same size.

Select [Move main window to front] or [Move main window to 

back] from the menu that appears by clicking the [Window] 

button.

 The main window is brought/sent 

to the front/back of window stack.

1 Select the image whose size is the desired size (W-23).

2 Click [Standardize window size] from the menu that appears by 

clicking the [Window] button.

 All the displayed preview windows 

are set to the same size as the 

selected image.

Bringing/Sending the Main Window to the 
Front/Back of Window Stack

Equalizing the Display Sizes in the 
Preview Window
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Editing Images
You can edit all the images that can be displayed in EOS Viewer Utility.

You can protect important images to prevent them from being accidentally deleted.

You can rotate a selected image by 90-degree increments left or right.

When multiple images are selected, the edits are applied to all the selected images.

Click the [Protect] button.

 When the image is protected, the  

[ ] icon appears in the frame of 

the image.

 Clicking the [Remove protect] 

button removes the [ ] icon from 

the frame of the image, and clears 

the protection.

 The [ ] is automatically displayed for images that were protected on the camera.

 Protection only prevents images from being deleted. Other types of image operations 

can still be performed for protected images.

 Alternatively, you can perform the same operation using the menu that appears by 

right-clicking.

Click the [Rotate right 90 degrees] or [Rotate left 90 degrees] 

button.

 The image rotates 90 degrees in 

the selected direction.

 Images that were shot with the camera held vertically with [Auto rotate] setting to 

<ON> are automatically displayed vertically.

 If a rotated image is displayed in another application, the image may not appear 

rotated.

 Alternatively, you can perform the same operation using the menu that appears by 

right-clicking.

Protecting Images

Rotating Images
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You can move unnecessary images to the Recycle Bin on your computer and delete them.

You can check the information recorded with images and input comments.

1 Click the [Erase images] button.

 The images are moved to the 

Recycle Bin.

2 Select [Empty Recycle Bin] from the menu that appears by right-

clicking [Recycle Bin] on the desktop.

 The images are deleted.

 Images that you deleted by selecting [Empty Recycle Bin] in step 2 cannot be 

restored. Check carefully before deleting images.

 Protect important images (W-26) to prevent them from being accidentally deleted.

Alternatively, you can perform the same operation using the menu that appears by right-

clicking.

Image information display area

 The shooting information is displayed. 
The number of items displayed differs depending on the camera settings.

 You can copy the information as text data and paste it into another application.
 Clicking the [▼] button can hide the detailed image information display area.

You cannot insert a hard return in the comment input box.

When multiple images are selected, the information from the image selected last is 

displayed.

Deleting Images

Checking the Image Information and Entering Comments

Comment input box

You can use this box to type in a comment up to 120 characters long.
Type in your comment and press the <Enter> key.



W-28

Playing Back Sound
The sound recording mark is displayed for images for which sound was recorded.

You can use EOS Viewer Utility to print images in index format.

1 Select an image with [ ] displayed, and click the [Play sound] 

button.

 The [Audio Note] dialog box 

appears.

2 Adjust the sound with the buttons and slider.

1 Select images to be printed in index format (W-23).

2 Select the [File] menu � [Print Index].

 Printing begins.

If you wish to specify the printer settings, select the [File] menu � [Page Setup].

Plays back the 
recorded sound.

Pauses sound playback. Click the 

[ ] button to resume.

Closes the dialog box.
Stops sound 
playback.

Indicates the sound playback position.

Printing Images
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Editing RAW Images
You can specify the processing parameters for RAW images so that the RAW images are 

optimized for their intended purpose.

RAW images are processed based on the settings specified on the camera (including the 

processing parameters and white balance) and then displayed on the computer.

 When the following operations are performed, RAW images are processed and displayed:

• When the preview window is switched from the main window

• When the processing parameters are specified on the preview or main window

• When the image is converted to the TIFF or JPEG format and saved

• When the image is transferred to the specified retouching software

When the images are processed, it takes a while to display them.

 Approximate processing times

• The processing times given here are only approximations. Actual processing times 

vary widely depending on the images and the computer system.

• Processing times are based on Canon testing standards.

(OS: Windows XP; CPU: 2.2 GHz Pentium 4; RAM: 256 MB)

• The processing time in the retouching software includes starting up time of the retouching 

software (when using Adobe Photoshop 7.0).

Operation Details Processing Time

When the preview window is switched from the main window Approx. 4 sec.

When the image is transferred to the specified retouching 

software
Approx. 40 sec.

You cannot display images in the preview window (W-20) or edit RAW images saved on 

a memory card in the camera directly. Before working images with EOS Viewer Utility, be 

sure to download images saved on a memory card to your computer.

Processing RAW Images
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W-30

You can specify the processing parameters in the RAW adjustment tool palette.

 This processing applies the specified parameters virtually and does not affect the original 

RAW images in any way. Consequently, you can redo the processing as often as you like 

with different parameters and then reset the modified parameters to the settings used when 

the shot was taken.

 Linear processing can be specified when an image is saved or is transferred to retouching 

software (W-46, W-49).

1 Display the RAW images in the preview window (W-20).

 If the RAW adjustment tool palette is hidden, select the [View] menu � [Tool palette] 

to show it.

2 Specify the processing parameters (W-31 to W-44).

 Clicking the [Reset to Shot Settings] button restores the settings to the values used 

when the shot was taken.

 If you click the [Preview] checkbox, the specified processing parameters are applied 

to the RAW images in real time.

3 Click the [Update] button.

 The RAW images are processed 

according to the specified 

processing parameters.

 The specified processing 

parameters are automatically 

saved in images.

 When multiple images are selected, the specified processing parameters are applied 

to all the selected RAW images.

 If you have specified processing parameters in the main window, even though you do 

not select the [Preview] checkbox, the specified processing parameters are applied to 

the images in real time.

Specifying the Processing Parameters
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You can adjust the brightness of an image in the range of +/–2 stops in 0.1-stop increments.

Drag the slider left or right to adjust the brightness.

 The adjusted value is specified in 

the RAW adjustment tool palette.

Adjusting the Brightness (Digital Exposure Compensation)
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W-32

You can adjust the white balance in the images. You can then save white balance data on your 

computer (W-36) and register them on the camera (W-82).

Selecting the White Balance
You can select the white balance that is the closest to the light source when shots were taken.

Select the white balance from the list box.

White Balance Details
Color Temp.

K (Kelvin)

Auto Automatically adjusts the white balance. Approx. 3000 to 7000

Daylight For sunny daylight outdoors. Approx. 5200

Shade For shaded areas outdoors. Approx. 7000

Cloudy For cloudy or hazy days and during sunset. Approx. 6000

Tungsten For tungsten (light bulb) light. Approx. 3200

Fluorescent For fluorescent light. Approx. 4000

Flash When flash is used. Approx. 6000

Color Temp.
You can manually set color temperature for 

2800 to 10000K (in 100K increments) (W-33).
Approx. 2800 to 10000

 The selected white balance is specified in the RAW adjustment tool palette.

Adjusting the White Balance
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Specifying the Color Temperature
You can specify the color temperature to adjust the white balance.

1 Select [Color Temp.] from the list box.

2 Enter a color temperature.

 Enter the color temperature in the 

[Color Temp.] input box in the 

range of 2800K to 10000K (in 

100K increments).

 The entered color temperature is 

specified in the RAW adjustment 

tool palette.
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Click White Balance Function
You can automatically adjust the white balance simply by clicking a point in a white part of the 

image.

1 Click the [Click White Balance] button.

 When you move the cursor over 

the image, the cursor [ ] changes 

to [ ].

2 Click a point in a white part of the image.

 The white balance is adjusted so that the point clicked appears white.

 If you click on another point over the image, the white balance is adjusted again.

 To exit the click white balance, click the [Click White Balance] button.

 When you use Click White Balance Function, even though you do not select the 

[Preview] checkbox, the adjusted white balance is applied to the images in real time.

 When you use Click White Balance Function, [Click WB] is displayed in the [White 

Balance] list box.
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Correcting the White Balance
You can correct the standard color temperature of the white balance. By using this function, you 

can obtain the effectiveness similar to the color temperature converting filter or color 

compensating filter (third-party product). The range of compensation is 9 levels for each color.

 This function is especially useful for users who understand the role and effect of the color 

temperature converting filter or color compensating filter.

Drag the slider left and right to adjust the white balance.

[LB Filter] slider:

Equates to the LB (Light Balancing) filter for color temperature conversion. Dragging 

the slider toward B-side adds blue hue, and toward A-side, amber hue.

[CC Filter] slider:

Equates to the CC (Color Compensation) filter for color correction. Dragging the slider 

toward G-side adds green hue, and toward M-side, magenta hue.

 The corrected value is specified in the RAW adjustment tool palette.

One level of blue/amber hue is equal to five mireds of the color temperature converting 

filter. (Mired: the unit of the density of the color temperature converting filter)

The corrected value specified 
using the slider.

Correction value when shooting.
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You can save the adjusted white balance data on your computer and then register them on the 

camera as the personal white balance settings (W-82).

1 Adjust the white balance (W-32 to W-35).

2 Click the [Save White Balance Settings] button.

 The [Save As] dialog box appears.

3 Select the destination folder, enter the file name, and then click 

the [Save] button.

 The white balance data is saved.

Windows/Macintosh compatibility for white balance data

White balance data saved on your computer is compatible with EOS Viewer Utility for 

both Windows and Macintosh.

Saving the White Balance
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You can use the tone curve to adjust the colors and brightness. You can then save the adjusted 

tone curve on your computer (W-39) and register it on the camera (W-80).

1 Click the [Tone Curve] button.

 The [Tone Curve] dialog box 

appears.

2 Select the channel from the list box.

Adjusting the Color and Brightness (Adjust Tone Curve)

Tone Curve

Input box Output box

Open button (W-39) Save button (W-39)

Shot Settings button

Restores the image to its 
original condition when shots 
were taken.

Close button

Tone curve settings list 
box

Adjusts all the channels.
Adjusts the red channel.
Adjusts the green channel.
Adjusts the blue channel.



Editing RAW Images

W-38

3 Adjust the tone curve.

 Click the tone curve to show [■]

and drag it to a desired location.

Horizontal axis: Input level

Vertical axis: Output level

 To delete [■], select [■] and then 

press the <delete> key on the 

keyboard.

 Up to four of [■] can be shown.

 Alternatively, you can adjust the 

tone curve by selecting [■] on the 

tone curve and entering values 

directly into the [Input] / [Output] 

box.

4 Click the [Update] button on the RAW adjustment tool palette.

 The adjusted tone curve is applied 

to the image.

 While checking the adjusted tone 

curve, repeat steps 2 and 4 to 

make further adjustments.

5 Click the [Close] button.

 The [Tone Curve] dialog box 

closes.

Windows/Macintosh compatibility for tone curve data

Tone curve data saved on your computer is compatible with EOS Viewer Utility for both 

Windows and Macintosh.
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Saving the Tone Curve
You can save the adjusted tone curve.

Loading the Tone Curve
You can apply the saved tone curve to other images.

1 Adjust the tone curve (W-37).

2 Click the [Save] button.

 The [Save As] dialog box appears.

3 Select the destination folder, enter the file name, and then click 

the [Save] button.

 The tone curve is saved.

1 Click the [Open] button.

 The [Open] dialog box appears.

2 Open the folder containing the tone curve, select the file, and then 

click the [Open] button.

 The tone curve is loaded.

3 Click the [Update] button on the RAW adjustment tool palette.

 The tone curve is applied to the image.
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Tone Curve
A tone curve shows the brightness and color saturation for the original image (input) and the 

adjusted image (output) in the form of a line graph. You can use the tone curve to adjust the 

image brightness and color saturation values that were set by the camera automatically when 

the shot was taken.

The tone curve adjustment options include [RGB], which adjusts the input and output for the 

entire image in a single operation, as well as the [Rch], [Gch] and [Bch] settings that adjust 

each color individually. You can use the [Tone curve settings] list box to switch between the 

different channels as you make your adjustments.

The horizontal axis shows the brightness and color saturation for the unadjusted (input) image, 

with the left-hand end indicating shadow (darker areas of the image) and the right-hand end 

indicating highlights (brighter areas of the image).

The vertical axis shows the brightness and color saturation for the adjusted (output) image, with 

the lower end indicating shadow and the upper end indicating highlights. 

You can adjust the contrast of an image.

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.

Selecting the Contrast
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Use the procedure below to select the film-equivalent hue, chroma and color range (the range 

of colors that can be reproduced).

1 Click the [Standard] tab.

 The [Standard] tab sheet appears.

2 Select the color matrix from the list box.

Selecting the Color Matrix
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Settings of Color Matrix

Color Matrix Details

1 Standard
Reproduces the natural color saturation and tones.

Effective for reproducing the subject’s natural color tones.

2 Portrait
Reproduces the color tones suited to portraits.

Effective for reproducing beautifully natural skin tones.

3 H-saturat.

Reproduces the color saturation similar to that in high-chroma color 

slide film.

Effective for reproducing clear and vivid color tones.

4 Adobe RGB

Processes images so that the color space is compatible with Adobe 

RGB.

Mainly used for printing for business purpose.

Not recommended for users who do not have a knowledge of image 

processing and Adobe RGB DCF 2.0 (Exif 2.21). With a printer that 

does not support the sRGB PC environments or DCF 2.0 (Exif 2.21), 

the images are printed with moderate color tone. So, you need to 

process the images after shooting.

5 L-saturat.
Reproduces low color saturation.

Effective for making color tone moderate.

 The selected color matrix is specified in the RAW adjustment tool palette.

Color Matrix Color Space Color Saturation Color Tone

1 Standard sRGB Standard 0

2 Portrait sRGB Standard -2

3 H-saturat. sRGB Dark 0

4 Adobe RGB Adobe RGB Standard 0

5 L-saturat. sRGB Dark 0

You can attach the ICC profile to the image (W-45).
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Use the procedure below to specify the color saturation, color tone, and color space for the 

image.

1 Click the [Advanced] tab.

 The [Advanced] tab sheet 

appears.

2 Select the settings from the list boxes.

 The selected setting is specified in the RAW adjustment tool palette.

Selecting a negative value for [Color Tone] makes the color tone reddish, and a positive 

value, yellowish.

Adjusting the Color

[–2] strongly adjusts the colors so that skin tones 
appear redder while [–1] makes the same 
adjustment less strongly.
[0] applies the standard color matching adjustment.
[+2] strongly adjusts the colors so that skin tones 
appear yellower while [+1] makes the same 
adjustment less strongly.
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You can adjust the edge sharpness of an image.

Select an adjustment value from the list box.

 Higher values give higher levels of 

edge sharpening.

 The selected adjustment value is 

specified in the RAW adjustment 

tool palette.

Selecting the Sharpness
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Saving Images
You can convert and save RAW images to TIFF or JPEG images, and save JPEG images as 

another name. When you convert RAW images to the TIFF format and save them, the specified 

color space data (W-41 to W-43) is attached to each of images as the ICC profile automatically.

ICC stands for International Color Consortium.

1 Select images to be saved (W-23).

2 Click the [Save File] button and select [Convert and save in file] 

from the menu that appears.

 The [Save File] dialog box 

appears.

3 Specify the settings and click the [OK] button.

 The images are saved in the 

selected folder.

When you convert RAW images to the TIFF images and save them, the ICC profile is 

attached to each of images automatically.

When you wish to display the images with the ICC profile attached in the retouching 

software, it is recommended that you should use the software that supports the ICC 

profile reproducing more faithful colors.

Restores the settings to their 
original ones and closes the 
[Save File] dialog box.

Applies the settings 
and saves the image.
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Allows you to specify the folder in which the image will be saved.

The image is saved as a new image in the same folder as the selected image.

When the [Save in following specified folder] radio button has been selected, this button allows 
you to specify the folder in which the image will be saved. The name of the destination folder 
is displayed next to the [Browse] button.

Select a setting for [Quality] (compression ratio) when you have selected 
[JPEG] from the list box, from [4] through [1 (High Compression Ratio)]. 
Higher values give higher quality of the JPEG image.

If some of the images to be saved are RAW images, select [Do not convert], [JPEG], or [TIFF] 
for the conversion format. If you select [TIFF], you can select the number of bits used when you 
save images from [8bit/ch], [16bit/ch] or [16bit/ch linear]. If you select [JPEG], the images are 
saved in the [8bit/ch] format.
The extensions used for the saved files are shown below.

Conversion Format Extension

Do not convert .CR2

JPEG (8bit/ch) .JPG

TIFF (8bit/ch) .TIF

TIFF (16bit/ch, 16bit/ch linear) .TIF

If you click this checkbox, the JPEG images that were 
taken in the RAW+JPEG format are also to be saved.

Specify the resolution for 
saving images in a range of 
10 to 2000 pixels/inch.



Saving Images

W-47

W

3

W
o

rk
in

g
 w

it
h

 I
m

a
g

e
s
 i
n

 E
O

S
 V

ie
w

e
r 

U
ti
lit

y

Alternatively, you can perform the same operation using the menu that appears by right-

clicking.

Click this checkbox when you want to save the image without changing the name.

This is text inserted before the file number. You can enter up to 12 characters. 
When you enter text, an example appears in the [Example] field below the text box.

When the image files to be saved include images with sound, 
this option can save the sound files with the respective images.

Click this checkbox when saving the file after converting a RAW image to a JPEG 
image or TIFF image adds one of the following at the end of the file name.

Enter the number of digits in the sequential number 
that attaches to the file and the starting number used. 
A maximum of 9 digits can be specified.

Conversion Format File Name

JPEG RJ

TIFF (8bit/ch) RT8

TIFF (16bit/ch, 16bit/ch linear) RT16, RT16L
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Transferring Images to Retouching Software
You can transfer the images displayed in EOS Viewer Utility to retouching software.

The descriptions given here use Adobe Photoshop 7.0, as an example.

 In order to transfer images, you will need retouching software such as Adobe 

Photoshop.

 Be sure to specify the image transfer settings before transferring images.

1 Click the [Transfer images] button.

 The [Image Transfer] dialog box 

appears.

2 Click the [Browse] button.

 The [Open] dialog box appears.

3 Select the retouching software (Photoshop 7.0) to which the 

image will be transferred.

 Select the [C:] drive � [Program 

Files] � [Adobe] � [Photoshop 

7.0] � [Photoshop]. Then click the 

[Open] button.

 Photoshop is specified and the 

dialog box closes.
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4 Select the radio button and then select a folder in which the 

images to be transferred will be saved.

5 Specify [Output settings] and [File Name] and then click the [OK] 

button.

 See “Saving Images” (W-45) for the procedure for specifying [Output settings] and 

[File Name].

 Photoshop starts up and displays the transferred images.

 The transferred images are saved in the folder that you have selected in step 4.

 It is recommended that you should use the retouching software (third-party product) 

that supports 16-bit images for the one to be specified for the transfer image function.

 When you convert RAW images to the TIFF format and transfer them, the specified 

color space data (W-41 to W-43) is attached to each of the images as the ICC profile 

automatically. 

 Alternatively, you can perform the same operation using the menu that appears by 

right-clicking.

The images to be transferred are saved 
as new images in the same folder.

Click the [Browse] button and then select 
a folder in which the images to be 
transferred will be saved.
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Specifying the Preferences
You can make various settings for transferring images, the information displayed with thumbnail 

images, and the image resolution for converting RAW images to other formats.

1 Select the [File] menu � [Preferences].

 The [General Settings] dialog box appears.

2 Specify the settings and click the [OK] button.

 The settings are applied and the [General Settings] dialog box closes.

Allows you to select whether the folder that was open the last time is displayed or the 
specified folder is always displayed when EOS Viewer Utility starts up.

Select the information to be displayed below images, from [File Name] and [Shooting Date/Time]

Restores the settings to their original 
ones and closes the [General 
Settings] dialog box.

Applies the settings and closes 
the [General Settings] dialog box.

Restores the settings 
to the default settings.
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Setting the IPTC Information
IPTC stands for International Press Telecommunications Council and refers to a standard for 

communications and information exchange tags attached to images. The standard was 

established by newspaper and communications companies to allow problem-free transmission 

of images.

You can attach this IPTC information to JPEG images, or to TIFF and JPEG images that were 

converted from RAW images and saved with EOS Viewer Utility. You can also save the IPTC 

information on your computer, and then load the saved information and apply it to other images.

1 Select a JPEG image (W-23).

2 Click the [IPTC information] button.

 The [IPTC information] dialog box 

appears.

3 Enter information (W-52, W-53).

 Select any of [IPTC-1], [IPTC-2], or [IPTC-3] tab to display the tab sheet, and enter 

the information.

 The entered IPTC information can be saved on the dialog box that appears by 

clicking the [Save As] button.

 The saved IPTC information can be loaded on the dialog box that appears by clicking 

the [Read] button.

4 Click the [Save] button.

 The specified IPTC information is applied to the image.

5 Click the [OK] button.

 The [IPTC information] dialog box closes.

Windows/Macintosh compatibility for IPTC information settings data

IPTC information settings data saved on your computer is compatible with EOS Viewer 

Utility for both Windows and Macintosh.
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IPTC-1 tab
IPTC-2 tab IPTC-3 tab

Loads the IPTC information saved on your computer.

Saves the entered IPTC information on your computer.

Cancels the entered IPTC information.

Displays the image for which you will enter 
the IPTC information.

When multiple images are selected, this 
button displays the IPTC information for the 
previous image.

When multiple images are selected, this 
button displays the IPTC information for the 
next image.

Displays the image No. in a sequence.

Closes the [IPTC information] dialog box.

Settings on the [IPTC-1] tab sheet 

You can enter up to 64 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 2000 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

Displays the IPTC information entered before the 
[Previous] or [Next] button was clicked.

Applies the entered IPTC information to the image.
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Settings on the [IPTC-2] tab sheet 

You can enter up to 10 characters.

Select [Highest Priority (=1)], [Normal (=5)], or 
[Low Priority (=8)] from the list box.

You can enter up to 256 characters.

You can enter up to 8 characters.

You can enter up to 11 characters.

You can enter up to 32 characters.

Settings on the [IPTC-3] tab sheet 

You can enter up to 3 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 256 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.
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Merging Images with PhotoStitch
You can merge multiple JPEG images to create a panorama shot.

1 Click the [Start] button � select [All Programs] ([Programs] in 

other versions of Windows) � [Canon Utilities] � [PhotoStitch] �

[PhotoStitch].

 [PhotoStitch Launcher] appears.

2 Click the [Merge Images] button.

 PhotoStitch starts up.

 Follow the instructions in the guidance window to merge the images.

 Please refer to the PhotoStitch Help menu for more details.

 You cannot merge RAW images in PhotoStitch.

 Up to four images can be merged using PhotoStitch.

 You will need QuickTime 3.0 or later to save merge images made using PhotoStitch in 

the QuickTime VR format. If QuickTime 3.0 or later is not already installed on your 

computer, obtain and install it separately.
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Specifying Camera 

Settings in EOS 

Viewer Utility

This chapter describes how to specify the owner’s name and date/time, the 

Personal Functions, the Parameters, and the Personal White Balance in 

the camera.
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Shot Settings.......................................................................................... W-77

Specifying the Parameters ................................................................. W-78
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Specifying the Personal White Balance.............................................. W-82

Specifying the Color Matrix................................................................. W-84
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Specifying the Camera Settings
You can specify the owner’s name and date/time, the personal functions, the processing 

parameters, and the personal white balance, etc. in the camera.

1 Connect the camera to your computer (W-8).

 The dialog box on which the 

camera model is displayed 

appears.

 Your camera model is displayed in 

EOS XXX.

 For Windows Me, the [Scanner 

and Camera Wizard] dialog box 

appears.

 Click the [Cancel] button to close 

the open window.

2 Start up EOS Viewer Utility (W-12).

3 Click the [Camera Settings] button.

 The [Camera settings] dialog box 

appears.

4 Select a tab and specify the camera settings.

Sets up to 26 Personal Functions and 
applies the settings to the camera (W-58).

You can specify owner’s name and shooting 
date/time on the camera, and check the 
camera properties data and the status of the 
battery and the memory card (W-57).

Specifies parameters (W-78), tone curve (W-
80), personal white balance (W-82), color 
matrix (W-84), and JPEG quality (W-86) on the 
camera.
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Basic Settings
You can specify the owner’s name and date/time in the camera, and check the properties of a 

memory card (CF card, SD card) in the camera.

1 Display the [Camera settings] dialog box (W-56).

2 Select the [Basic settings] tab.

 The [Basic settings] tab sheet 

appears.

3 Specify the basic settings.

4 Click the [OK] button.

 The settings are applied and the [Camera settings] dialog box closes.

Imports the date and time from your 
computer.

This box shows whether a memory card 
is loaded in the camera along with the 
available space on the card and its total 
capacity.

Enter the name of a camera owner. 
You can enter up to 31 characters.

The battery level of the 
camera is indicated by 

[  ] or [  ].
When you are using the DC 

Coupler Kit, [  ] is displayed.

Restores the parameters to their original 
ones and closes the [Camera settings] 
dialog box.

Applies the settings that 
you have specified in the 
[Basic settings] tab sheet 
to the camera.

Enter a value or click the [�]/
[�] buttons to specify the 
date and time.

Applies the settings that you have 
specified in all the tab sheets to 
the camera and closes the 
[Camera settings] dialog box.

This box shows the camera model, body 
ID (serial number) and firmware version.
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Personal Function Settings
You can set up to 26 Personal Functions tailored to different types of photography and apply 

those function settings to the camera. You can also save the specified settings on your 

computer and load the saved settings. 

1 Display the [Camera settings] dialog box (W-56).

2 Select the [Personal functions] tab.

 The [Personal functions] tab sheet 

appears.

3 From the list box, select a window in which you wish to specify 

settings.

 The selected window appears.

 In the [Combination] window, you can check the specified personal function settings 

and the status of whether or not the settings are applied to the camera. You can also 

save and load the personal function settings (W-75).

Loads the details of the Personal Functions 
that have been specified on the camera.

Removes all the check marks from the 
windows.

Applies the settings that you have specified in 
all the tab sheets to the camera and closes the 
[Camera settings] dialog box.

Applies the settings that you 
have specified in the 
[Personal functions] tab 
sheet to the camera.

Restores the parameters to their original ones and 
closes the [Camera settings] dialog box.
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You can specify the Personal Function settings listed below in the different windows.

[Exposure functions 1]

Disables the shooting modes (W-62)

Disables the metering modes (W-62)

[Exposure functions 2]

Specifies the metering mode for manual exposure (W-63)

Sets the maximum and minimum shutter speeds to be used (W-63)

Sets the maximum and minimum apertures to be used (W-64)

[Exposure functions 3]

Registers and switches the shooting mode and metering mode (W-64)

Repeats bracketing during continuous shooting (W-66)

Sets the number of shots to be bracketed (W-66)

Changes the bracketing sequence for C.Fn-09-2/3 to increased exposure, 

standard exposure, and decreased exposure (W-66)

Retains the shift amount for program shift (W-67)

[AF functions]

Disables focus detection (search driving) by the lens drive (W-68)

Disables the AF-assist beam from being emitted (W-68)

Enables automatic shooting when focus is achieved at the fixed point of focus while 

the shutter button is pressed fully (W-69)

Disables automatic AF point selection (W-69)

Enables automatic AF point selection when C.Fn-11-2 has been set (W-70)

[Drive functions]

Sets the continuous shooting speed (W-70)

Limits the number of shots during continuous shooting (W-70)

Enables quiet operation when the shutter button is OFF after picture-taking (W-71)
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[Other functions 1]

Changes the timer’s time length (W-71)

Illuminates the LCD panel during bulb exposures (W-72)

[Other functions 2]

Sets the default settings when the CLEAR button is ON (W-72)

[Other functions 3]

Shortened release time lag (W-72)

Enables the electronic dial’s function to be used in the reverse direction (W-73)

Prevents exposure compensation with the Quick Control Dial (W-73)

Enables Quick Control Dial switch to turn on/off Main Dial too (W-73)

Add original decision data (W-74)

[Combination]

Allows you to check the settings (W-75)

Allows you to save the settings (W-76)

Allows you to load the saved settings (W-76)

* Omission of P.Fn-11, 12, 13, 22 and 29

To match the numbers and descriptions for the Personal Functions to the EOS-1 series, some 

numbers have been omitted.

4 Set up the Personal Function (W-62 to W-74).

 If you select the checkbox, the selected item takes effect.

 If you enter a numerical value, values outside the valid range of settings are ignored.

 Clicking the [Load settings] button acquires the settings with the Personal Function 

settings on the camera.

 Clicking the [Reset] button removes all the check marks from the windows.

 If the Personal Function settings are saved on your computer, the saved settings can 

be loaded (W-76).

Checkbox
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5 Check the settings and save them on your computer if necessary 

(W-75, W-76).

6 Click the [OK] button.

 Applies the settings and closes the [Camera settings] dialog box.

 When a Personal Function is 

applied to the camera, < > 

appears on the LCD panel.
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 The  shown in this section provides brief descriptions of the Custom Function Settings 

for the respective camera functions. For more details, refer to “Custom Function Settings” in 

the camera’s Instruction Manual.

Disables the shooting modes

 Click the shooting modes you do not want to use.

 Unwanted shooting modes can be skipped while you are selecting the shooting mode.

 This makes selecting the desired shooting mode faster.

Disables the metering modes

 Click the metering modes you do not want to use.

 Unwanted metering modes can be skipped while you are selecting the metering mode.

 This makes selecting the desired metering mode faster.

At least one checkbox must be left unchecked.

At least one checkbox must be left unchecked.

Description of Personal Functions
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Specifies the metering mode for manual exposure

 Select the metering mode to be specified.

 You can specify the metering mode to be used in the manual exposure mode. 

 When you set the manual exposure mode, the metering mode selected here will be set 

automatically. In the manual exposure mode, this enables you to use a metering mode 

different from the one used in the AE modes. 

Sets the maximum and minimum shutter speeds to be used

 Select the maximum and minimum shutter speeds from the list box.

 For example, if you set 1/2000 sec. as the fastest shutter speed and 1/60 sec. as the 

slowest, the shutter speed range will be 1/2000 to 1/60 sec.

 This makes shutter speed selection faster and prevents a slow-speed sync. in aperture-

priority AE mode with the flash.

If you set the maximum and/or minimum shutter speed to one that is not a full-stop 

increment (such as 1/750 sec.), the controllable and settable shutter speed range might 

not be as exact as you set it. (A slight deviation may occur.) This applies if you also set 

Custom Function C.Fn-6-1 and C.Fn-6-2 and set the maximum and/or minimum shutter 

speed to one that is not a full-stop increment (such as 1/3200 sec.).

 To ensure that a proper flash sync speed is set in the Program AE mode, a shutter 

speed range of 1/200 sec. to 1/80 sec. cannot be set.

 If safety shift has been enabled (with C.Fn-16), it will override P.Fn-04’s shutter speed 

range.
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Sets the maximum and minimum apertures to be used

 Select the maximum and minimum apertures from the list box.

 For example, if you set 1.4 for the largest aperture and 8.0 for the smallest aperture, the 

usable aperture range will be f/1.4 to f/8.0.

 You can better control the apertures used by setting the range of usable apertures.

Registers and switches the shooting mode and metering mode

 While you press the <  > button, you can select the preset shooting mode, exposure 

setting (such as the aperture for aperture-priority AE), metering mode, and exposure 

compensation amount.

 Select settings that are appropriate for each shooting mode.

 The modes and settings are preset with the camera.

See “Registering the Modes and Settings with the Camera” for information on the camera 

procedures (W-65).

 Convenient when you want to instantly select the preset modes and settings to suit a 

particular shooting situation such as backlit or front-lit conditions.

 Specify a minimum aperture value that is smaller than the maximum aperture setting. 

If you select a minimum aperture value that is larger than the maximum aperture, a 

warning message appears and the setting reverts to the default value.

 If you set the maximum and/or minimum aperture to one that is not a full-stop 

increment (such as f/4.5), the controllable and settable aperture range might not be 

as exact as you set it. (A slight deviation may occur.) This applies if you also set 

Custom Function C.Fn-6-1 or C.Fn-6-2 and set the maximum and/or minimum 

aperture to one that is not a full-stop increment (such as f/6.3).

 If the largest aperture of the attached lens is smaller than the largest aperture you set 

with P.Fn-05, the largest aperture will be set to the largest aperture of the lens. And if 

the smallest aperture of the attached lens is larger than the smallest aperture you set 

with P.Fn-05, the smallest aperture will be set to the smallest aperture of the lens.

 If safety shift has been enabled (with C.Fn-16), it will override P.Fn-05’s aperture 

range.
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Registering the Modes and Settings with the Camera ( )

1 Set the shooting mode and shooting mode settings (aperture 

setting for aperture-priority AE mode). Then set the metering 

mode and exposure compensation amount.

2 Register the modes and settings.

 First press the <  > button, then 

press the <  > button.

 <  > appears in the LCD panel, 

indicating that the modes and 

settings have registered.

 The registered modes and 

settings can be modified any 

number of times.

To register the modes and settings, first press the <  > button before the <  > 

button. If you press the <  > button first, the camera will only select the registered 

modes and settings instead.

 Bulb cannot be preset.

 You cannot select the registered modes and settings during continuous shooting.

 If P.Fn-03 has been set to specify the metering mode for manual exposure, and  P.Fn-

06 is used to register the manual exposure mode and a metering mode different from 

the one specified with P.Fn-03, you can select the metering mode specified with P.Fn-

03 by pressing the <  > button.

 If P.Fn-04 and/or P.Fn-05 has been set, set the shutter speed and aperture within the 

range specified with P.Fn-04 and/or P.Fn-05.

 If the shooting and metering modes you want to set are excluded by the restrictions in 

P.Fn-01 and P.Fn-02, those Personal Functions must be disabled. For information on 

clearing and resetting Personal Functions, refer to “Clearing and Resetting Personal 

Functions” in the camera’s Instruction Manual.

 Even if the shooting and metering modes selected by P.Fn-06 are excluded by the 

restrictions in P.Fn-01 and P.Fn-02, they are still valid for P.Fn-06.

 If C.Fn-4-1 or C.Fn-4-3 has been set, AF and AE will also take effect when you 

press the <  > button.

 When C.Fn-18 is set, P.Fn-06 is disabled.
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Repeats bracketing during continuous shooting

 While you hold down the shutter button, bracketing repeats continuously in the currently 

selected drive mode.

 This function is useful when you want to continuously repeat the bracketing sequence.

Sets the number of shots to be bracketed

 Select the number of shots from the list box.

 The usual 3-frame bracketing is changed to 2-, 3-, 5-, or 7-frame bracketing.

 In bracketing shots, if you select 5-frame bracketing with 1-stop increment, the bracketing 

for the shots is –2, –1, 0, +1 and +2.

 This function is useful for adjusting the range of bracketing.

Changes the bracketing sequence for C.Fn-09-2/3 to increased 

exposure, standard exposure, and decreased exposure

 The bracketing sequence when C.Fn-09-2/3 is selected (decreased exposure � standard 

exposure � increased exposure) changes to increased exposure � standard exposure �

decreased exposure.

 This function is useful when you want to start the bracketing sequence with a increased 

exposure frame.

 Even when the setting is outside the bracketing level display range, the exposure is 

compensated as specified.

 This function can be used in combination with C.Fn-09-2/3 and P.Fn-09.

This function can be used in combination with P.Fn-08.
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Retains the shift amount for program shift

 Normally, any program shift amount is canceled after you take the picture. This Personal 

Function retains the program shift amount.

 This function is useful when you want to shift the standard program line so that priority is 

given to the shutter speed or to the aperture.

By shifting the program, you can change the shutter speed or aperture and still retain the same 

exposure level. Under the same brightness, you can shift the program line toward the right to 

set a faster shutter speed and a larger aperture (lower f/number). Or you can shift the program 

line toward the left to set a slower shutter speed and a smaller aperture (higher f/number).

P.Fn-10 retains the amount of program shift. Select the appropriate amount of shift for the level 

of priority you want to give to the shutter speed or aperture setting.

 The program shift amount remains in effect until you set it back to the standard program 

manually or replace the battery or press the CLEAR button (QUALITY+WB).

 The shift amount is retained even after you change the lens.
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� Shutter Speed
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Disables focus detection (search driving) by the lens drive

 Normally, when you press the shutter button halfway and focus cannot be achieved, the lens 

is driven to search the correct focus. This lens driving operation can be turned off.

 When focus has been achieved once and refocusing fails, the subsequent lens driving 

operation can result in grossly inaccurate focus. This subsequent lens driving operation is 

turned off. P.Fn-14 is especially suited for super telephoto lenses.

Disables the AF-assist beam from being emitted

 This disables the external Speedlite’s built-in AF-assist beam.

 At a joint photo session, etc., this prevents the AF-assist beam’s pattern projected on the 

subject from being photographed by other photographers.

If autofocusing is attempted while the lens is way out of focus, the lens may stop 

operating. Focus manually until the subject outline becomes discernable, then 

autofocus.
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Enables automatic shooting when focus is achieved at the 

fixed point of focus while the shutter button is pressed fully

 This takes the picture automatically when the subject comes to the preset focusing distance. 

Focusing detection is performed using the selected AF point.

 Set the lens focus mode switch to <MF> and focus manually at the desired point of focus.

 Keep pressing the shutter button fully.

 Using an accessory like Remote Controller RS-80N3 which can lock the shutter button 

relieves you from holding down the shutter button while you wait for the subject.

Disables automatic AF point selection

 When you select beyond the peripheral AF point, the selection stops there. It makes 

selecting a peripheral AF point faster.

 Because the camera remains on standby while the shutter button is fully pressed, 

battery power is used up more quickly. For long periods of photography, use the DC 

Coupler Kit.

 When this function is used in combination with a flash, the flash remains on standby 

at full charge. Consequently, the flash batteries are used up more quickly. (The 

Speedlite’s SE mode is disabled.)

 When you use a flash with this function, set the drive mode to single-frame shooting. 

If you select continuous shooting, the flash will be unable to charge in time for 

successive shots and will not fire at full charge.

 If you set the drive mode to continuous shooting, set the number of shots in P.Fn-20. 

If you do not use P.Fn-20, once the camera focuses on the subject, continuous 

shooting will continue until the capacity of the memory card is reached.

 P.Fn-16 cannot be used with manual focus lenses or with lenses that are too slow to 

be used with autofocusing.

 Do not use this function when C.Fn-4-1/3 is set as shots will be taken regardless of 

whether the image is in focus.

Using an accessory like Remote Controller RS-80N3 which can lock the shutter button is 

recommended.

 If C.Fn-11-2 has been set, you can switch to automatic AF point selection by pressing 

the <  > button during autofocusing. (� “Selecting the AF Point” in the camera’s 

Instruction Manual)

 If automatic AF point selection has been preset at [AF frame registration] setting, the 

preset setting remains valid. (� “Registering and Switching the AF Point” in the 

camera’s Instruction Manual)



Personal Function Settings

W-70

Enables automatic AF point selection when C.Fn-11-2 has been 

set

 Enables the standard horizonal AF point selection together with automatic AF point 

selection with C.Fn-11-2.

 Convenient when you want to use automatic AF point selection while C.Fn-11-2 has been 

set.

Sets the continuous shooting speed

 In the list box, select the speed of continuous shots during continuous shooting.

 By reducing the maximum continuous shooting speed, AI Servo AF continuous shooting can 

be more stable.

Limits the number of shots during continuous shooting

 This enables you to enter the maximum number of shots to be exposed during continuous 

shooting while the shutter button is pressed fully.

 Convenient when you do not want to shoot an unwanted scene that follows.

If P.Fn-17 [Disables automatic AF point selection] has also been set, P.Fn-17 will 

override P.Fn-18 to disable automatic AF point selection.

In AI Servo AF, it may not be possible to complete the selected speed of continuous 

shots.
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Enables quiet operation when the shutter button is OFF after 

picture-taking

 When single-frame shooting is selected, this function selects quiet camera operation when 

you release the shutter button from the fully pressed position to the half way position.

 This is useful when the camera operation noise would be disturbing after you take the 

picture.

Changes the timer’s time length

 After you press and release a button, the respective function remains active for a specific 

number of seconds. You can change this number of seconds as necessary.

 The function’s activation time can be set from 0 to 3600 sec. (1 hour).

 If the standard activation time is too short or too long, you can adjust it.

If you select continuous shooting, the camera operates normally.

Setting mirror lockup with C.Fn-12 will further reduce the shooting noise.

6 sec. Timer  After you press the shutter button halfway or the <  > button.

16 sec. Timer  FE lock time after you press the <  > button.

Post-shutter

release timer

 Exposure setting retaining time after the picture is taken. Setting 

this to a longer time can make it easier to shoot with AE lock.

 LCD panel illumination time after the picture is taken.

Be aware that a longer activation time will consume more battery power. The battery life 

will become shorter and fewer number of shots can be taken with the battery.

To turn off the function’s activation time midway, press the <  > button, <  > 

button or <  > button.
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Illuminates the LCD panel during bulb exposures

 After the bulb exposure starts, press the <LCD panel illumination> button to illuminate the 

LCD panel until the bulb exposure ends.

 Convenient when you want to monitor the elapsed bulb exposure time.

Sets the default settings when the CLEAR button is ON

 You can use this function to select the default mode selected when you press the CLEAR 

button (QUALITY+WB).

 Convenient when you want to instantly switch to frequently-used settings.

Shortened release time lag

 Normally, the shutter-release time lag is controlled for stability. This Personal Function 

eliminates this control. As a result, the shutter-release time lag can be reduced by as much 

as about 20 percent when the aperture needs to be stopped down by no more than 3 stops.

 This is effective when a shorter shutter-release time lag is more important than a stable 

shutter-release time lag.

Taking bulb shots for long periods speeds up battery charge depletion and reduces the 

number of available shots.

Since the difference is in 10-millisecond increments, the time lag may not feel any 

shorter.
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Enables the electronic dial’s function to be used in the reverse 

direction

 The electronic dial’s rotational function can be reversed for selecting the AF point and 

setting the shutter speed and aperture.

 By matching the dial’s rotation direction to the particular operation, the operation can feel 

more intuitive.

Prevents exposure compensation with the Quick Control Dial

 The Quick Control Dial cannot be used to set exposure compensation.

 This prevents exposure compensation from being set accidentally while the AF point is 

being selected.

Enables Quick Control Dial switch to turn on/off Main Dial too

 Setting the Quick Control Dial switch to <OFF> disables the Main and Quick Control Dials.

When the main dial’s rotational function is reversed, the horizontal AF point selection 

direction does not change.
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Add original decision data

 The data that shows whether or not the image is the original one can be added to the image.

When selecting the display format of Shooting information (INFO), the icon showing the 

captured image with Original image verification data is displayed.

For more details, refer to “Shooting Information Display” in the camera’s Instruction Manual.

 For the decision of the original image, you will need the dedicated accessory (optional).

The original decision data cannot be added to the JPEG or TIFF image converted from 

the RAW image.
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You can check the specified personal functions and the status of whether or not the settings are 

applied to the camera. You can also save the settings on your computer and then load the 

saved settings and apply them to the camera.

1 Specify the personal functions (W-62 to W-74).

2 Select [Combination] from the list box.

 The [Combination] window 

appears.

3 Check the settings, save and load them (W-76).

 You can check the Personal Function settings and check if these settings are applied 

on the camera.

Checking, Saving, and Loading Personal Function Settings
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Saving the Settings

Loading the Settings

1 Click the [Save as] button.

 The [Save As] dialog box appears. 

2 Select the destination folder, enter the file name, and then click 

the [Save] button.

 The specified Personal Function settings are saved.

To update an existing file, click the [Save] button.

1 Click the [Open] button.

 The [Open] dialog box appears.

2 Open the folder containing the settings, select the file, and then 

click the [Open] button.

 The Personal Function settings data saved in that file are loaded.

Windows/Macintosh compatibility for Personal Function settings data

Personal Function settings data saved on your computer is compatible with EOS Viewer 

Utility for both Windows and Macintosh.
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Shot Settings
You can specify various shot settings, such as processing parameters, tone curve, personal 

white balance settings, color matrix, and JPEG quality, and then apply these settings to the 

camera.

1 Display the [Camera settings] dialog box (W-56).

2 Select the [Shoot settings] tab.

 The [Shoot settings] tab sheet 

appears.

3 Click one of the buttons to display each dialog box.

4 Click the [OK] button.

 The settings are applied to the camera and the [Camera settings] dialog box closes.

Allows you to select tone curves, specify 
the sharpness and contrast, and then 
register these settings on the camera 
(W-78)

Loads the saved tone curves, and allows 
you to select color channels and register 
them on the camera (W-80).

Loads the personal white balance settings, 
and then registers them on the camera 
(W-82).

Allows you to select color matrix settings 
and then register them on the camera 
(W-84).

Allows you to specify JPEG quality 
settings (L, M1, M2, S), and register them 
on the camera (W-86).

Applies the settings that you have specified in all 
the tab sheets to the camera and closes the 
[Camera settings] dialog box.

Restores the parameters to their original ones and 
closes the [Camera settings] dialog box.

Applies the settings that you have 
specified in the [Shoot settings] tab sheet 
to the camera.
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You can select tone curves, specify the sharpness and contrast, and then register up to three 

sets of these settings on the camera as processing parameters.

 For more information on setting the processing parameters on the camera, refer to “Setting 

the Processing Parameters” in the camera’s Instruction Manual.

1 Click the [Parameters] button (W-77).

 The [Parameters settings] dialog 

box appears.

2 Select the [Set 1], [Set 2], or [Set 3] tab.

3 Specify the tone curve, sharpness, and contrast.

Specifying the Parameters

[Standard]:
The standard tone curve is set.

[TCD 1] through [TCD 3]:
The tone curve that has been 
selected in “Specifying the 
Tone Curve” (W-80) is set.

Drag the slider left or right to specify the sharpness.
Higher values give higher levels of edge sharpening.

Drag the slider left or right to specify the contrast.
Higher values give higher levels of contrast.
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4 Click the [Applay to camera] button.

 The [Confirm settings] dialog box appears.

5 Confirm the settings and click the [Yes] button.

 The parameter is registered on the 

camera.

6 Click the [Close] button.

 The [Parameters settings] dialog box closes.
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You can download saved tone curves from a computer and register up to three (W-39) as tone 

curve data on the camera. You can also select the tone curve data that has been loaded into 

the [TCD 1] through [TCD 3] tab sheets, from the list box shown in “Specifying the Parameters” 

(W-78).

 For more information on registering the tone curve data ([TCD 1] through [TCD 3]) on the 

camera, refer to “Setting the Processing Parameters” in the camera’s Instruction Manual.

1 Click the [Tone curve] button (W-77).

 The [Tone curve settings] dialog 

box appears.

2 Select the [TCD 1], [TCD 2] or [TCD 3] tab.

3 Click the [Open] button.

 The [Open] dialog box appears.

4 Open the folder containing the tone curve, select a file, and then 

click the [Open] button.

 The tone curve is loaded.

Specifying the Tone Curve
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5 Select a channel from the list box.

6 Click the [Apply to camera] button.

 The tone curve is registered on the camera.

7 Click the [Close] button.

 The [Tone curve settings] dialog box closes.
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You can download saved white balance data from a computer and register up to three (W-36) 

as personal white balance on the camera.

 When you upload a personal white balance setting to the camera, <  > to <  >  

is displayed on the panel located on the back of the camera.

 For more information on setting the personal white balance on the camera, refer to 

“Selecting the White Balance” in the camera’s Instruction Manual.

1 Click the [Personal white balance] button (W-77).

 The [Personal white balance 

settings] dialog box appears.

2 Select the PC (Personal White Balance) to be registered from the 

list.

Specifying the Personal White Balance
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3 Click the [Open] button.

 The [Open] dialog box appears.

4 Open the folder containing the saved white balance, select the 

file, and then click the [Open] button.

 The white balance is loaded.

Displays the setting status for the PC (Personal White Balance) 
registered on the camera along with their titles.

Registers the selected 
PC (Personal White 
Balance) settings on 
the camera.

Deletes the selected 
PC (Personal White 
Balance) from the 
camera.

Enter a title for the personal 
white balance to be registered.
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You can specify the color space, color saturation, and color tone, and then register up to two 

sets of these settings on the camera. You can also select the predetermined color matrix from 

the list box, which helps you to specify the settings

 For more information on setting the color matrix on the camera, refer to “Selecting the Color 

Matrix” in the camera’s Instruction Manual.

5 Enter a title in the [Title] input box.

6 Click the [Apply to camera] button.

 The white balance is registered on the camera.

 To register another setting, repeat steps 2 to 6. You can register up to 3 settings (PC-

1, PC-2 and PC-3).

 To delete a registered setting, select the PC (Personal White Balance) from the list 

and click the [Delete from camera] button.

7 Click the [Close] button.

 The [Personal white balance settings] dialog box closes.

1 Click the [Color matrix] button (W-77).

 The [Color Matrix settings] dialog 

box appears.

2 Select [CM set1] or [CM set2] from the list box.

 This activates the [Color space], 

[Saturation], and [Color tone] list 

boxes.

 If you select any color matrix 

setting other than [CM set1] or 

[CM set2], you cannot register the 

settings on the camera.

Specifying the Color Matrix
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3 Select desired settings from the list boxes.

4 Click the [Apply to camera] button.

 The color matrix is registered on the camera.

5 Click the [Close] button.

 The [Color Matrix settings] dialog box closes.
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You can specify the JPEG quality for each of the sizes, L (Large), M1 (Middle 1), M2 (Middle 2), 

and S (Small), and then register the settings on the camera.

 For more information on setting the JPEG quality on the camera, refer to “Setting the Image-

recording Quality” in the camera’s Instruction Manual.

1 Click the [JPEG quality] button (W-77).

 The [JPEG quality settings] dialog 

box appears.

2 Drag the slider left or right to adjust the JPEG quality.

 Higher values give a lower compression ratio and higher image quality for any size.

3 Click the [Apply to camera] button.

 The JPEG quality is registered on the camera.

4 Click the [Close] button.

 The [JPEG quality settings] dialog box closes.

Specifying the JPEG Quality
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Remote Shooting in 

EOS Viewer Utility

This chapter describes how to use the Remote Shooting function in EOS 

Viewer Utility for taking shots and specifying the camera settings remotely 

from your computer.

For more information on the restrictions of remote shooting, refer also to the source 

listed below.

Readme: Click the [Start] button � select [All Programs] ([Programs] in other 

versions of Windows) � [Canon Utilities] � [EOS Viewer Utility xx] (“xx” 

is the version) � [EOS Capture Readme].

Starting the Remote Shooting Function.............................................. W-88

Remote Shooting ................................................................................... W-90

Single-frame Shooting ........................................................................ W-90

Timer Shooting ................................................................................... W-91

Interval Timer Shooting ...................................................................... W-92

Specifying the Camera Settings........................................................... W-93

Specifying the Save Destination......................................................... W-93

Camera Settings................................................................................. W-94

Processing Parameters ...................................................................... W-96



W-88

Starting the Remote Shooting Function

1 Connect the camera to your computer (W-8).

 The dialog box on which the 

camera model is displayed 

appears.

 Your camera model is displayed in 

EOS XXX.

 For Windows Me, the [Scanner 

and Camera Wizard] dialog box 

appears.

 Click the [Cancel] button to close 

the open window.

2 Start up EOS Viewer Utility (W-12).

3 Select the folder to save the image in.

 Select a folder in the Folder Tree 

Area to save the image in, or 

create a new folder (W-16). (The 

[Capture] folder is created in the 

[My Pictures] folder here as an 

example.)
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4 Select the [Option] menu � [EOS Capture].

 The EOS Capture main window appears.

EOS Capture main window

 To exit the Remote Shooting function, select the [File] menu � [Exit].

EOS Capture is one of the functions of EOS Viewer Utility. Therefore, when you exit EOS 

Viewer Utility, EOS Capture also exits.

5 Click the [Release] button to take a shot (W-90).

Allows you to check and 
specify the camera 
settings (W-94).

Release button (W-90)

Status

Displays the status while 
specifying the settings.

 button (W-96)

Shows/hides the set 
processing 
parameters dialog 
box.
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Remote Shooting
You can control the camera from your computer and take single-frame shots, timer shots and 

interval timer shots. The images are automatically saved on your computer.

Before you use the Remote Shooting function, be sure to check that the camera is ready 

for shooting. If the camera is not ready for shooting (the lens is not attached, etc.), you 

cannot perform the operation as shown below.

1 Set the camera up ready to shoot.

2 Make various settings.

 See “Camera Settings” (W-94) and “Processing Parameters” (W-96) for information 

on how to specify the camera settings.

 See “Specifying the Save Destination” (W-93) for information on how to specify the 

settings for saving images.

3 Click the [Release] button.

 The shot images are displayed in 

EOS Viewer Utility and saved in 

your computer automatically.

Pressing the space bar allows you to shoot.

Single-frame Shooting
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Approximate Transfer Times for Shooting RAW Images

• The transfer times given here are only approximations. Actual transfer times vary 

widely depending on the images and the computer system.

• The times for images shot in JPEG format will be shorter than those shown above.

• Transfer times are based on Canon testing standards. 

(Time until images appear in the EOS Viewer Utility main window after you uncheck the 

[Save also on the camera’s memory card] checkbox and click the [Release] button in the 

EOS Capture main window using the following: OS: Windows XP; CPU: 2.2 GHz Pentium 

4; RAM: 256 MB)

 When the camera is set to One Shot AF, you cannot take shots if the camera cannnot 

focus.

If you cannot take shots with the auto focusing, focus manually and then take a shot.

 If you take remote shooting while you are using the Explorer in the WIA Driver to 

display images on the camera, Remote Shooting function may not operate correctly.

The number of available shots changes depending on the available capacity on your 

computer’s hard disk. You can check the number of available shots with the [Shots to 

Go] (W-94).

1 Select the [Tool] menu � [Timer shooting].

 The [Timer shooting setting] dialog box appears.

2 Enter a delay time and click the [OK] button.

 You can set a value between 0 

seconds and 99 minutes 59 

seconds in 1-second increments.

 Timer shooting shots are taken.

Transfer Time Approx. 10 sec.

Timer Shooting
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1 Select the [Tool] menu � [Timer shooting].

 The [Timer shooting setting] dialog box appears.

2 Click the [Interval timer shooting] checkbox.

3 Enter the shooting interval and the number of shots. Then click 

the [OK] button.

 You can set a shooting interval 

between 5 seconds and 99 

minutes 59 seconds in 1-second 

increments.

 You can set up to a maximum of 

1999 shots.

 Interval timer shooting is 

performed using the specified 

interval between shots and the 

specified number of shots.

On some types of computers, if you set a short interval between shots and there is 

insufficient time to download and save the images, it may not be possible to take shots at 

the specified interval. If this occurs, set a longer interval between shots and take the 

shots again.

Interval Timer Shooting
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Specifying the Camera Settings
You can check and change the settings in the camera from your computer remotely.

You can specify save destination files and file names.

Save settings dialog box

Before you specify the settings, be sure to check that the camera is ready for shooting. If 

the camera is not ready for shooting (the lens is not attached, etc.), you cannot make 

some of the settings.

1 Select the [File] menu � [Save destination settings].

 The [Save settings] dialog box appears.

2 Specify desired settings and click the [OK] button.

Specifying the Save Destination

Allows you to change the destination 
folder to which images will be saved. The 
name of the destination folder is displayed 
next to the [Browse] button.

Applies the settings and closes the [Save settings] dialog box.

Cancels all the settings, and restores the 
settings to their original ones.

Clicking the checkbox saves images on 
the memory card in the camera.

Use this field to enter a file name when 
saving an image. The file name can consist 
of up to 18 characters.

Enter a sequential number with a range of 
0000 to 9999 that is added to the end of the 
file name.
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You can check and specify the camera settings.

1 Check the camera settings.

‘

* The above window shows all the information at once. In actual use, only the 

information needed is displayed.

Camera Settings

Shooting mode

Displays/specifies 
the shooting mode.

White Balance
Displays/specifies 
the white balance.

Exposure compensation
Displays/specifies the exposure 
compensation value.

Image recording quality

Displays/specifies the 
image recording quality.

ISO Speed

Displays/specifies the ISO 
speed.

Aperture value

Displays/specifies Av (aperture value).
(not displayed when Shutter-priority AE or Program 
specified for the shooting mode)

Shutter speed

Displays/specifies Tv (shutter speed).
(not displayed when Aperture-priority AE or 
Program AE is specified for the shooting mode)

Save destination display

Displays the destination 
folder to which images will 
be saved.
(When you select the [Save 
also on the camera’s 
memory card] checkbox, 
the camera/PC icon is 
displayed, and when you 
deselect the checkbox, the 
PC icon is displayed.)

Color temp.

Specify the color temperature in a range 
of 2800K to 10000K.

Metering mode

Displays/specifies 
the settings of the 
metering mode.

AF mode

Displays the settings 
of the AF mode.

Drive mode

Displays the settings of the drive mode.

Warning display

Displayed when the remote shooting is 
impossible due to inappropriate settings.

Battery status

The battery level of the camera is 
indicated by [  ] or [  ].
When you are using the DC Coupler 

Kit, [  ] is displayed.

Shots to Go
Displays the number of 
available shots.

Bracket shots

Displays the settings for 
bracketing shots.
(displayed when any of WBB/
AEB/ISOB/FEB is specified)
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2 Click the icon.

 The icon displayed here shows 

exposure compensation as an 

example.

3 Use the button to change a value.

 The changed settings are applied to the camera.

1-step down settings button

Allows you to decrease the value by 1 step.

Minimum settings button

Specifies the minimum value.

1-step up settings button

Allows you to increase the value by 1 step.

Maximum settings button

Specifies the maximum value.
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You can specify the processing parameters displayed in the camera.

 If the [Set processing parameters] dialog box has not appeared, click the [ ] button.

Change the settings.

 Use the slider and list box to specify the settings.

 The changed settings are applied to the camera.

Processing Parameters

CC Filter slider

Allows you to correct the white balance using the digital color filter 
for green/magenta hue.

LB Filter slider

Allows you to correct the white balance using the digital color 
filter for blue/amber hue.



W

6

Downloading JPEG 

Images with the Driver

This chapter describes how to download JPEG images using the WIA 

Drivers for Windows XP or Windows Me, and the TWAIN Drivers for 

Windows 2000 or Windows 98 SE.

A number of restrictions apply to the WIA Driver. You must read the “WIA 

Driver Readme” file before using the WIA Driver.

Readme: Click the [Start] button � select [All Programs] ([Programs] in Windows 

Me) � [Canon Utilities] � [EOS XXX WIA Driver] � [WIA Driver 

Readme].

For more information on the restrictions of the TWAIN Driver, refer also to the 

sources listed below.

Readme: Click the [Start] button � select [Programs] � [Canon Utilities] � [EOS 

XXX TWAIN Driver] � [TWAIN Driver Readme].

Help: Displayed by clicking the [Help] button in the TWAIN Driver main 

window.

Your camera model is displayed in EOS XXX.

Downloading Images with the WIA Driver........................................... W-98

Downloading with [Scanner and Camera Wizard] .............................. W-98

Downloading with Explorer ............................................................... W-100

Downloading with the WIA TWAIN ................................................... W-101

Downloading Images with the TWAIN Driver .................................... W-102
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Downloading Images with the WIA Driver
You can download JPEG images using the [Scanner and Camera Wizard] dialog box, Explorer 

or WIA TWAIN.

 See Chapter 3 to download RAW images.

You can download JPEG images to your computer by following the instructions on the dialog 

boxes.

1 Connect the camera to your computer (W-8).

 The dialog box on which the camera model is displayed appears.

 For Windows Me, the [Scanner and Camera Wizard] dialog box appears. Proceed to 

step 3.

2 Select [Microsoft Scanner and Camera Wizard], and then click the 

[OK] button.

 The [Scanner and Camera 

Wizard] dialog box appears.

 Your camera model is displayed in 

EOS XXX.

3 Click the [Next] button.

 The [Choose Pictures to Copy] 

dialog box appears.

 For Windows Me, the [Picture 

Selection] dialog box appears.

Downloading with [Scanner and Camera Wizard]
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4 Select the image(s) you wish to download and click the [Next] 

button. 

 To select multiple images, press 

and hold the <Ctrl> or <Shift> key 

on the keyboard while clicking on 

images. To select all the images, 

click the [Select All] button.

 The [Picture Name and 

Destination] dialog box appears.

 For Windows Me, the [Picture 

Destination] dialog box appears.

5 Select the destination folder, enter the file name and click the 

[Next] button.

 The images are downloaded and the [Other Options] dialog box appears.

 If you do not select the destination folder, a new folder is created in [My Pictures] and 

images are saved in that folder.

 For Windows Me, select the destination folder, enter the file name and click the 

[Finish] button. The images are saved and the [Picture Destination] dialog box closes.

6 Select the [Nothing. I’m finished working with these pictures] 

radio button and click the [Next] button.

 The [Completing the Scanner and Camera Wizard] dialog box appears.

7 Click the [Finish] button.

 The images are saved and the 

[Scanner and Camera Wizard] 

dialog box closes.
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You can download JPEG images to your computer by dragging and dropping them. 

1 Connect the camera to your computer (W-8).

 The dialog box on which the camera model is displayed and the [Scanner and 

Camera Wizard] dialog box appear.

 Click the [Cancel] button to close all the open windows.

2 Start up Explorer and select a folder.

 You can start Explorer by right-

clicking the [Start] button and 

selecting [Explorer] from the menu 

that appears.

 In the Explorer view, double-click 

the connected camera’s icon �

[CF_SLOT] folder and then click 

the [xxxEOSXXX] folder (For 

Windows Me, double-click the 

[xxxEOSXXX] folder).

 “xxx” represents a number 

between 100 and 999, and 

“EOSXXX” represents the camera 

model on which shots were taken.

 The camera’s images will be 

displayed as thumbnails in the 

Explorer view.

3 Save the image.

 Drag and drop the image to the 

folder in the Explorer view.

 The image is saved.

If you attempt to use Remote Shooting while you are using Explorer to display images on 

the camera, the Remote Shooting function may not operate correctly.

Downloading with Explorer
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You can download JPEG images to your computer by using the TWAIN Driver-compatible 

retouching software. The descriptions given here use Adobe Photoshop 7.0, as an example.

1 Connect the camera to your computer (W-8).

 The dialog box on which the camera model is displayed and the [Scanner and 

Camera Wizard] dialog box appear.

 Click the [Cancel] button to close all the open windows.

2 Start Photoshop.

 Click the [Start] button � select [All Programs] ([Programs] in Windows Me) � [Adobe 

Photoshop 7.0].

 Photoshop starts up.

3 Select the [File] menu � [Import] � [WIA-EOSXXX].

 The [Get Pictures from Canon EOS XXX] dialog box appears.

4 Select the image(s) you wish to download and click the [Get 

Pictures] button.

 The selected image(s) will be 

downloaded to Photoshop.

The method for starting the application and the dialog box contents differ depending on 

your retouching software. Refer to the retouching software User’s Manual for details.

Downloading with the WIA TWAIN
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Downloading Images with the TWAIN Driver
You can download JPEG images to your computer by using the TWAIN Driver-compatible 

retouching software. The descriptions given here use Adobe Photoshop 7.0, as an example.

 See Chapter 3 to download RAW images.

1 Connect the camera to your computer (W-8).

 The dialog box on which the camera model is displayed appears.

 Click the [Cancel] button to close all the open windows.

2 Start Photoshop.

 Click the [Start] button � select [Programs] � [Adobe Photoshop 7.0].

 Photoshop starts up.

3 Select the [File] menu � [Import] � [Canon EOSXXX].

 The TWAIN Driver starts and the 

JPEG image in the camera is 

displayed.

 To exit the TWAIN Driver, select   

the [File] menu � [Exit]. 

4 Select the image to be transferred and select the [File] menu �

[Transfer Images].

 The image transferred to Photoshop is displayed.

You cannot display or download the images saved on an SD card.

 You can also transfer images by double-clicking a thumbnail image.

 The method for starting the application and the dialog box contents differ depending 

on your retouching software. Refer to the retouching software User’s Manual for 

details.
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Troubleshooting and 

Uninstallation

This chapter provides troubleshooting and describes the software 

uninstallation procedures.

Troubleshooting .................................................................................. W-104

Uninstalling the Software.................................................................... W-108

Uninstalling the Software.................................................................. W-108

Uninstalling the Driver ...................................................................... W-109

Index ..................................................................................................... W-117
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Troubleshooting
When the “Could not complete installation correctly” or “Communication between the camera 

and computer failed” message appears, check the items described below.

 The camera name is shown in the operation screens as “EOS XXX”.

 If you are using Windows XP Professional or Windows 2000, are you using 

the computer under a user setting other than [Computer administrator] or 

[Administrator]?

� You cannot install software if a user setting other than [Computer administrator] or 

[Administrator] is selected. Select the [Computer administrator] user setting in Windows 

XP Professional or the [Administrator] user setting in Windows 2000. For detailed 

information on selecting the user setting, refer to the computer User’s Manual.

 Is the cable firmly plugged into its socket?

� To complete the installation, ensure that the plugs on the dedicated cable are securely 

plugged into the ports on the camera and computer when you connect the camera to 

your computer (W-8).

 Are the camera and computer set up correctly for communication?

� Is the camera’s power switch set to <ON>?

� Even when the camera’s power switch is set to <ON>, operation of the Auto power off 

function will automatically switch the camera off. To prevent this, set the Auto power off 

function to [Off]. (Refer to “Menu Operations” in the camera’s Instruction Manual.)

 Does the [Add New Hardware Wizard] ([Found New Hardware Wizard] in 

Windows 2000) dialog box appear during installation?

� Click the [Cancel] button, disconnect the dedicated cable, and then repeat the 

installation procedure from the beginning. 

 Doesn’t the installer panel appear?

� Use the following procedure to display the installer panel.

Click the [Start] button � [My Computer]. (In other versions of 

Windows, double-click [My Computer] on the desktop.) � right-

click the CD-ROM drive containing the CD � select [Open] from 

the menu that appears � double-click the icon on the right.

Installation failed.
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 Is the driver installed?

� The driver is required for communications between the camera and computer. When you 

want to communicate between the camera and computer, be sure to install the driver 

shown below appropriate to your windows.

• Windows XP/Windows Me: WIA Driver

• Windows 2000/Windows 98 SE: TWAIN Driver

 Have you installed the WIA Driver or TWAIN Driver?

� Even if you have installed the WIA Driver or TWAIN Driver, installation is not completed 

unless the camera is connected to the computer. Insert the Solution Disk into the CD-

ROM drive, install the WIA Driver or TWAIN Driver, and then connect the camera to your 

computer.

 Does your computer comply with these requirements?

� PC with Windows XP, Windows 2000, Windows Me or Windows 98 SE preinstalled and 

equipped with an IEEE1394 port (W-2).

* Operation is not guaranteed when an IEEE1394 connection is used on computer 

systems other than those listed above.

 Are the camera and computer connected correctly?

� Connect the camera to your computer correctly using the dedicated cable (W-8).

 Is there sufficient charge left in the camera battery?

� Your computer does not supply power to the camera. Connect the DC Coupler Kit to the 

camera or load a fully charged battery into the camera before connecting it to your 

computer.

 Do you have more than one camera connected to your computer?

If you connect more than one camera to the same computer, the driver and camera may not 

operate normally.

� Exit the software and disconnect all the dedicated cables. Then connect only one 

camera to the same computer again.

I have installed the software but the camera and 
computer cannot communicate.
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 Is the driver operating normally?

Connect the camera to your computer 

with the dedicated cable and set the 

camera’s power switch to <ON> (W-8) 

and open [Device Manager] (W-107). 

Click the plus symbol [+] to the left of 

[Imaging devices] and check that the 

connected camera is displayed.

� If the connected camera is not displayed, the driver is not operating normally. Briefly 

disconnect and then reconnect the dedicated cable, ensuring that the connection is 

secure. If the connected camera still does not appear, use the following procedure to re-

install the driver.

1 Disconnect the dedicated cable and delete the driver (W-109).

2 Re-install the driver (W-4).

� When the [X], [!] or [?] symbol is displayed beside the connected camera, part of the 

driver is missing or corrupted. Use the following procedure to re-install the driver.

1 Delete the camera displayed in [Imaging devices].

2 Disconnect the dedicated cable and delete the driver (W-109).

3 Re-install the driver (W-4).

 Is the driver installed correctly?

Connect the camera to your computer with the dedicated cable and set the camera’s power 

switch to <ON> (W-8) and open [Device Manager] (W-107). Click the plus symbol [+] to the 

left of [Other devices] or [Unknown devices] and check whether the connected camera or 

[Canon Digital Camera] is displayed.
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� If the connected camera or [Canon Digital Camera] is displayed in [Other devices] or 

[Unknown devices], the driver was not installed correctly. Use the following procedure to 

re-install the driver.

1 Delete the camera or [Canon Digital Camera] displayed in [Other devices] or 

[Unknown devices].

2 Disconnect the dedicated cable and delete the driver (W-109).

3 Re-install the driver (W-4).

 Did you set the camera’s power switch to <ON>?

� If you did not set the camera’s power switch to <ON>, proceed as follows:

1 Disconnect the dedicated cable from the camera and computer.

2 Install the Solution Disk software on your computer using the correct installation 

procedure (W-4) and then connect the camera to your computer to complete the 

installation (W-8).

� If you set the camera’s power switch to <ON>, proceed as follows:

1 If [Found New Hardware Wizard] or any other dialog boxes appear, click the [Cancel] 

buttons to cancel all the dialog boxes.

2 Set the camera’s power switch to <OFF>.

3 Disconnect the dedicated cable from the camera and computer.

4 Install the Solution Disk software on your computer using the correct installation 

procedure (W-4) and then connect the camera to your computer to complete the 

installation (W-8).

I connected the camera to the computer before 
installing the software

To Display the Device Manager
 Windows XP

� Click the [Start] button � select [Control Panel] � [Performance and Maintenance]

� [See basic information about your computer]. Then select the [Hardware] tab 

and click the [Device Manager] button.

 Windows 2000

� Click the [Start] button � select [Settings] � [Control Panel]. Then double-click the 

[System] icon to open and select the [Hardware] tab and click the 

[Device Manager] button.

 Windows Me and Windows 98 SE

� Click the [Start] button � select [Settings] � [Control Panel]. Then double-click the 

[System] icon to open and select the [Device Manager] tab.
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Uninstalling the Software
 Before beginning the software uninstallation, exit all programs you are using and disconnect 

the dedicated cable from your computer.

The following uses the procedures for uninstalling EOS Viewer Utility as an example for 

uninstalling other programs as well.

 For information on uninstalling the WIA Driver or TWAIN Driver, see “Uninstalling the Driver” 

(W-109).

 For Windows XP Professional or Windows 2000, log in using computer Administrator 

privileges.

 To prevent computer malfunctions, always restart your computer after you have uninstalled 

the software. Re-installing the software without first restarting your computer is likely to 

result in computer malfunctions.

1 Click the [Start] button � select [All Programs] ([Programs] in 

other versions of Windows) � [Canon Utilities] �

[EOSViewerUtility xx] � [EOSViewerUtility Uninstall].

 EOS Viewer Utility version information is displayed in xx.

2 Proceed with the uninstallation as directed by the on-screen 

messages.

 Software is uninstalled.

Uninstalling the Software
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To uninstall the driver, you must first uninstall the WIA Driver or TWAIN Driver, then remove the 

camera information from the [Scanners and Cameras Properties] dialog box or the [Scanners 

and Cameras] dialog box, and then delete the driver settings files.

 For Windows XP Professional or Windows 2000, log in using computer Administrator 

privileges.

 To prevent computer malfunctions, always restart your computer after you have uninstalled 

the driver. Re-installing the driver without first restarting your computer is likely to result in 

computer malfunctions.

 The camera name is shown in the operation screens as “EOS XXX”.

1 Uninstall [EOS XXX WIA Driver] or [EOS XXX TWAIN Driver].

 Your camera model is displayed in EOS XXX.

 For Windows XP or Windows Me, click the [Start] button � select [All Programs] 

([Programs] in Windows Me) � [Canon Utilities] � [EOS XXX WIA Driver] � [WIA 

Driver Uninstall].

 For Windows 2000 or Windows 98 SE, click the [Start] button � select [Programs] �

[Canon Utilities] � [EOS XXX TWAIN Driver] � [TWAIN Driver Uninstall].

2 Proceed with the uninstallation as directed by the on-screen 

messages.

 The driver is uninstalled.

3 Connect the camera to your computer.

 If the dialog box on which the camera model is displayed or the [Scanner and Camera 

Wizard] dialog box appears, click the [Cancel] buttons to close all open windows.

4 Click the [Start] button � [Control Panel] � [Printers and Other 

Hardware] � [Scanners and Cameras].

 In other versions of Windows, click the [Start] button � select [Settings] � [Control 

Panel]. Then double-click the [Scanners and Cameras] icon.

 For Windows XP or Windows Me, the [Scanners and Cameras] dialog box appears.

 For Windows 2000 or Windows 98 SE, the [Scanners and Cameras Properties] dialog 

box appears.

Uninstalling the Driver
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5 Delete the camera information in the [Scanners and Cameras] 

dialog box.

 For Windows XP or Windows Me, 

select and right-click the camera 

that you are using and then select 

[Delete] from the menu that 

appears. When the confirmation 

message appears, click the [Yes] 

button.

 For Windows 2000 or Windows 98 

SE, select the camera that you are 

using and click the [Remove] 

button.

 If the camera that you are using is 

not displayed in the [Scanners and 

Cameras] dialog box or the 

[Scanners and Cameras 

Properties] dialog box, close the 

dialog box and proceed as follows.

If drivers for other devices such as scanners are already installed, those device names 

are displayed. Take particular care not to delete the wrong driver.

6 Display [Device Manager] (W-107).

7 Delete the camera information from [Device Manager].

For Windows XP and Windows 2000 users:
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 If the camera that you are using is displayed when you click the plus symbol [+] to the 

left of [Imaging devices] or [Other devices], select [Delete] on the menu that appears 

by right-clicking the camera that you are using, and then click the [OK] button.

 If the camera that you are using is displayed in both [Imaging devices] and [Other 

devices], or multiple cameras are displayed in [Other devices], delete all of them in 

the same way.

 If the camera that you are using is not displayed or after it is deleted, click the [OK] 

button and then proceed to the next step.

For Windows Me and Windows 98 SE users:

 If the camera that you are using is displayed when you click the plus symbol [+] to the 

left of [Imaging devices] or [Other devices], select the camera that you are using and 

click the [Remove] button. When the confirmation message appears, click the [OK] 

button.

 If the camera that you are using is displayed in both [Imaging devices] and [Other 

devices], or multiple cameras are displayed in [Other devices], delete all of them in 

the same way.

 If the camera that you are using is not displayed or after it is deleted, click the [OK] 

button and then proceed to the next step.

8 Delete the driver settings files.

 The method for deleting the settings files differs depending on your Windows.

Refer to the information on the following pages to delete the settings files.

• Windows XP (W-112)

• Windows 2000 (W-113)

• Windows Me, Windows 98 SE (W-115)
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Deleting the Driver Settings Files

For Windows XP users:

Mistakenly deleting the wrong files can cause Windows to malfunction. Check the file 

names carefully before deleting any files.

1 Click the [Start] button � select [Control Panel] � [Appearance 

and Themes] � [Folder Options].

 The [Folder Options] dialog box appears.

2 Select the [View] tab.

 The [View] tab sheet appears.

3 Select the [Show hidden files and folders] radio button and then 

deselect the [Hide extensions for known file types] checkbox.

 If these settings are already 

selected, simply proceed to the 

next step.

4 Click the [OK] button to close the [Folder Options] dialog box.

 Previously hidden folders and files now become visible.

5 Click the [Start] button � [My Computer].

6 Double-click [C:] drive � the [WINDOWS] folder � the [Inf] folder 

to open.
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For Windows 2000 users:

7 Search for files called [Oem*.inf] or [Oem*.pnf].

 Substitute a number such as 1 or 2 for the asterisk (*). Also, because [Oem*.inf] and 

[Oem*.pnf] files come in pairs, substitute the same number for the asterisk in each 

pair (e.g. Oem2.inf and Oem2.pnf).

 The [Inf] folder may contain multiple pairs of [Oem*] files.

8 Check the contents of the [Oem*.inf] files.

 Double-click an [Oem*.inf] file to display the file contents. Check that [; **** Canon 

Camera Driver Setup File ****] appears on the first line.

 If there are multiple [Oem*.inf] files, repeat this procedure.

 Once you have identified the target file or files, make a note of the file names.

9 Delete the [Oem*.inf] and [Oem*.pnf] files you identified.

The [Inf] folder contains a large number of files. Mistakenly deleting the wrong files can 

cause Windows to malfunction. Check the file names carefully before deleting any files.

1 Click the [Start] button � select [Settings] � [Control Panel].

2 Double-click the [Folder Options] icon.

 The [Folder Options] dialog box appears.

3 Select the [View] tab.

 The [View] tab sheet appears.
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4 Select the [Show hidden files and folders] radio button and then 

deselect the [Hide file extensions for known file types] checkbox.

 If these settings are already 

selected, simply proceed to the 

next step.

5 Click the [OK] button to close the [Folder Options] dialog box.

 Previously hidden folders and files now become visible.

6 In [My Computer] on the desktop, open [C:] � the [WINNT] folder 

� the [Inf] folder.

7 Search for files called [Oem*.inf] or [Oem*.pnf].

 Substitute a number such as 1 or 2 for the asterisk (*). Also, because [Oem*.inf] and 

[Oem*.pnf] files come in pairs, substitute the same number for the asterisk in each 

pair (e.g. Oem2.inf and Oem2.pnf).

 The [Inf] folder may contain multiple pairs of [Oem*] files.

8 Check the contents of the [Oem*.inf] files.

 Double-click an [Oem*.inf] file to display the file contents. Check that [; **** Canon 

Camera Driver Setup File ****] appears on the first line.

 If there are multiple [Oem*.inf] files, repeat this procedure.

 Once you have identified the target file or files, make a note of the file names.

9 Delete the [Oem*.inf] and [Oem*.pnf] files you identified.

The [Inf] folder contains a large number of files. Mistakenly deleting the wrong files can 

cause Windows to malfunction. Check the file names carefully before deleting any files.
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For Windows Me and Windows 98 SE users:

1 Click the [Start] button � select [Settings] � [Control Panel]. 

Then double-click the [Folder Options] icon.

 For Windows 98 SE, click the [Start] button � select [Settings] � [Folder Options].

 The [Folder Options] dialog box appears.

2 Select the [View] tab.

 The [View] tab sheet appears.

3 Select the [Show hidden files and folders] radio button (the [Show 

all files] radio button in Windows 98 SE) and then deselect the 

[Hide file extensions for known file types] checkbox.

 If these settings are already selected, simply proceed to the next step.

4 Click the [OK] button to close the [Folder Options] dialog box.

 Previously hidden folders and files now become visible.

5 In [My Computer] on the desktop, double-click [C:] � the 

[Windows] folder � the [INF] folder (the [inf] folder in Windows 98 

SE) to open.

Windows Me Windows 98 SE
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6 Delete [DRVDATA.BIN] and [DRVIDX.BIN] files.

7 Double-click the [Other] folder in the [INF] folder to open.

8 Delete the [Canon.IncCAP_1DM2.inf] file if it exists.

 “1DM2” is displayed in place of “XXX” in the file name.

 The [Canon.IncCAP_1DM2.inf] file may not exist depending on your computer 

system.

The [INF] folder contains a large number of files. Mistakenly deleting the wrong files can 

cause Windows to malfunction. Check the file names carefully before deleting any files.
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Describes how to install the bundled software.

2 Preparation for Downloading Images .......................................................M-7

Explains how to connect the camera or a card reader (third-party product) to your 

computer.

3 Working with Images in EOS Viewer Utility ...........................................M-11

Explains how to use EOS Viewer Utility to download images to your computer, edit and 

save images, and transfer the downloaded images to the retouching software.

4 Specifying Camera Settings in EOS Viewer Utility................................M-55

Describes how to specify the owner’s name and date/time, the Personal Functions, the  

Parameters, and the Personal White Balance in the camera.

5 Remote Shooting in EOS Viewer Utility..................................................M-87

Describes how to use the Remote Shooting function in EOS Viewer Utility for taking shots 

and specifying the camera settings remotely from your computer.

6 Troubleshooting and Uninstallation .......................................................M-97

Provides a troubleshooting and describes the software uninstallation procedures.
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Where explanations are common to all operating systems, the screens used in the examples 

are from Mac OS X (10.2). In this chapter, Mac OS X and Mac OS 9.2 are referred to as OS X 

and OS 9 respectively.

M
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System Requirements
The software bundled with this product runs on the systems described below.

 These software programs are not compatible with UFS (Unix File System) formatted disks 

on Mac OS X.

 A CD-ROM drive is required for installation.

OS
Mac OS X (version 10.2 recommended),

Mac OS 9.0 to 9.2 (Mac OS 9.2 recommended)

Computer
Macintosh with one of the above OS installed and a FireWire 

(IEEE1394) port as a standard feature

CPU Power PC

RAM
Mac OS X: Minimum 256 MB

Mac OS 9.0 to 9.2: Minimum 128 MB

Interface FireWire (IEEE1394)

Hard disk space
EOS Viewer Utility/EOS Capture: 300 MB or more

PhotoStitch: 30 MB or more

Display
Resolution: 1024  768 or more

Colors: Thousands or more
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Installing the 

Software

This chapter describes how to install the bundled software.

Installing the Software .............................................................................M-4
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Installing the Software
 Check that your Macintosh complies with the system requirements for the software (M-2) as 

you follow the installation procedure.

1 Start up your Macintosh.

 Quit any programs that are running.

2 Insert the CD (EOS DIGITAL Solution Disk).

 The CD icon appears on the 

desktop.

3 Start installation.

 Double-click the CD icon � the 

[Mac OS X] folder. Then double-

click the icon on the right.

 For OS 9, double-click the [Mac 

OS 9] folder in the CD window and 

then double-click the icon on the 

right.

 The Installer panel appears.

4 Click the [Install] button.

OS X

OS 9
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5 Select [Easy Installation] and click the [Next] button.

6 Check the details of the License Agreement and then click the 

[Agree] button.

7 Check the folder in which the software will be installed and then 

click the [Next] button.

 Installation begins. It takes 

approx. 2 to 3 minutes.
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8 Finish the installation.

 Click the [OK] button.

9 Click the [Exit] button.

10Once the installation is complete, remove the CD.

 Connect the camera to your 

computer in Chapter 2.
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Preparation for 

Downloading Images

This chapter explains how to connect the camera or a card reader (third-

party product) to your computer.

Connecting the Camera to Your Computer............................................M-8

Using Your Card Reader ........................................................................M-10
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Connecting the Camera to Your Computer
Before downloading images to your computer or specifying the camera settings, you must 

connect the camera to your computer with the dedicated FireWire (IEEE1394) cable. 

You can connect the camera while your computer is running.

1 Plug the dedicated cable into the computer.

 Plug the cable into the FireWire 

(IEEE1394) port.

 Refer to the computer User’s 

Manual for information on the 

terminal areas.

2 Plug the dedicated cable into your camera.

 Open the cover and plug the cable  

into the < > terminal.

3 Set the camera’s power switch to <ON>.

 The camera is now ready to 

communicate with your computer.

 Proceed to Chapter 3 

continuously.
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 Never perform the following operations while the software installed from the Solution 

Disk is running after connecting the camera to the computer as a communications 

error may occur.

• Set the camera’s power switch to <OFF>.

• Open the memory card slot cover.

• Disconnect the dedicated cable, remove the battery, and then remove the DC 

coupler.

• Disconnect the AC adapter’s plug or power cord.

Before you perform the operations above, be sure to quit all the software.

 Use only the dedicated FireWire (IEEE1394) cable.

 Push the plug firmly all the way into the socket. Loose connections can cause faults 

or malfunctions.

 Do not connect the camera to your computer via a hub. Or do not connect multiple 

FireWire (IEEE1394) devices to your computer. If you do so, the camera may not 

operate correctly.

 Operation of the Auto power off function will automatically switch the camera off, 

disabling to communicate with your computer. Set the Auto power off function to 

[OFF] in advance. (Refer to “Menu Operations” in the camera’s Instruction Manual.)

 Do not connect more than one camera to the same computer. The connections may 

not operate correctly.

 While the camera and your computer are communicating, the camera’s LCD panel 

may blink or the image on the monitor may flicker. However, this is not a malfunction.

 When unplugging the dedicated cable, be sure to grip the sides of the plug as you pull 

it out.

 If you do not perform any operation while the camera and computer are connected, a 

confirmation message appears on the computer screen asking whether you wish to 

continue communicating with the camera for some computer systems. If you do not 

perform any operation even after this message appears, the communication with the 

camera is terminated. To re-establish the communication, press the shutter button 

down halfway or set the camera’s power switch to <OFF> and then back to <ON>.

 Do not put your computer to sleep while it is connected to the camera.

If your computer goes into the sleep mode, never disconnect the dedicated cable 

while your computer is still in sleep mode. Always wake your computer up while it is 

connected to the camera. On some types of computer, disconnecting the dedicated 

FireWire (IEEE1394) cable while your computer is in sleep mode could prevent the 

computer from waking up correctly. Refer to the computer User’s Manual for more 

information on sleep mode.

When the camera is connected to a computer, you should use the DC Coupler Kit.
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Using Your Card Reader
Users with a third-party card reader can download images directly from a memory card to the 

computer.

1 Remove the memory card from the camera.

2 Load the card into the card reader.

 Proceed to Chapter 3.

For information on connecting the card reader to your computer, refer to the card reader 

User’s Manual.
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Working with Images 

in EOS Viewer Utility

This chapter explains how to use EOS Viewer Utility to download images to 

your computer, edit and save images, and transfer the downloaded images 

to the retouching software.

For more information on the restrictions of EOS Viewer Utility, refer also to the source 

listed below.

ReadMe: Double-click the [Canon Utilities] folder � the [EOS Viewer Utility] folder 

� [ReadMe].

Starting EOS Viewer Utility .......... M-12

Downloading Images.................... M-16

Handling the Folders .................... M-18

Memory Card Folder Structure and File 

Names ........................................ M-18

Registering Frequent Use Folder ...M-19

Selecting the Image Display Mode..M-20

Main Window (Thumbnail Display)...M-20

Preview Window Display............. M-20

Selecting the Display Size .......... M-22

Checking the AF Point ................ M-22

Selecting Images .......................... M-23

Selecting Images in the Main Window.M-23

Selecting Images in the Preview Window.M-23

Attaching Check Marks to Images...M-24

Selecting Images by Condition ... M-24

Bringing/Sending the Main Window to 

the Front/Back of Window Stack. M-25

Equalizing the Display Sizes of the 

Preview Window ......................... M-25

Editing Images .............................. M-26

Protecting Images ....................... M-26

Rotating Images.......................... M-26

Deleting Images.......................... M-27

Checking the Image Information and 

Entering Comments .................... M-27

Playing Back Sound ..................... M-28

Printing Images............................. M-28

Editing RAW Images .................... M-29

Processing RAW Images............ M-29

Specifying the Processing Parameters..M-30

Adjusting the Brightness (Digital 

Exposure Compensation) ........... M-31

Adjusting the White Balance....... M-32

Saving the White Balance........... M-36

Adjusting the Color and Brightness 

(Adjust Tone Curve).................... M-37

Selecting the Contrast ................ M-40

Selecting the Color Matrix........... M-41

Adjusting the Color ..................... M-43

Selecting the Sharpness............. M-44

Saving Images .............................. M-45

Transferring Images to Retouching 

Software ........................................ M-48

Specifying the Preferences ......... M-50

Setting the IPTC Information ....... M-51

Merging Images with PhotoStitch...M-54
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Starting EOS Viewer Utility

1 Connect the camera to your computer (M-8).

2 Double-click the [Canon EOS Viewer Utility] icon on the desktop.

 The main window appears.

 You can also start EOS Viewer Utility by double-clicking the [Canon Utilities] folder �

the [EOS Viewer Utility] folder � the [EOS Viewer Utility] icon.
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Main window

* The above window shows all the information at once. In actual use, only the information 

needed is displayed.

 For OS X, to quit EOS Viewer Utility, select the [EOS Viewer Utility] menu � [Quit EOS 

Viewer Utility].

 For OS 9, to quit EOS Viewer Utility, select the [File] menu � [Quit].

Main window tool bar Histogram

Shows the distribution of the brightness of an image.
Selecting the tab switches the histogram display 
values between Brightness and RGB.Path display

Displays the connected camera, drive and folder on your computer.

Image display areaStatus bar

Comment input box (M-27)

Bookmark area (M-19)

Detailed Image display area (M-27)

Tree View Area (M-16)

RGB value display
When you move the cursor over an image, the 
coordinates of the cursor position and its RGB values 
(8-bit conversion) are shown here.
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Main window tool bar

* The above window shows all the information at once. In actual use, only the information 

needed is displayed.

Show/Hide Tree View button

Shows/hides the Tree View Area.

Display Size list box 
(M-22)

Rotate right 90 degrees button (M-26)

Remove protect 
button (M-26)

Remove Check 
Mark button (M-24)

Transfer images button 
(M-48)

protect button (M-26)

Erase images 
button (M-27)

Save File button 
(M-45)

Select Image button (M-24)

Show/Hide Thumbnail Frames button

Shows/hides the information display frame 
of thumbnail images.

Add Check Mark 
button (M-24)

Rotate left 90 degrees button (M-26)

Show/Hide Image Information button

Shows/hides the histogram, image 
information display area, and comment 
input box.

Camera Settings 
button (M-56)

IPTC information button 
(M-51)

Play sound button (M-28)

Window button 
(M-25)
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RAW adjustment tool palette

 When you select a RAW image, the name of the camera on which the selected RAW image 

was taken and its settable processing parameters are displayed.

 If you select the [Advanced] tab, the [Advanced] tab sheet appears.

* The above tool palette shows all the information at once. In actual use, only the information 

needed is displayed.

In the RAW adjustment tool palette you cannot edit JPEG images, or TIFF and JPEG 

images that were converted from RAW images with EOS Viewer Utility.

 The settings used when shots were taken are listed in italic type in the list box.

 If the RAW adjustment tool palette is hidden, select the [View] menu � [Tool palette] 

to show it.

Digital Exposure 
Compensation slider (M-31)

Camera type (M-30)
Displays the name of the camera on which the selected RAW images were taken.

Advanced tab sheet (M-43)

Color Temp. input 
box (M-33)
White Balance list box 
(M-32, M-33)

LB Filter slider (M-35)

CC Filter slider (M-35)

Contrast list box (M-40)

Standard tab sheet (M-41)

Color Matrix list box (M-41)

Sharpness list box (M-44)

Preview checkbox (M-30)

Digital Exposure Compensation 
Value display box (M-31)

Save White Balance 
Settings button (M-36)

Click White Balance button 
(M-34)

LB Filter Compensation 
Value display box (M-35)

Reset to Shot Settings button (M-30)

CC Filter Compensation 
Value display box (M-35)

Update button (M-30)

Adjust Tone Curve button 
(M-37)

Color Space list box (M-43)

Color Tone list box (M-43)

Color Saturation list box (M-43)
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Downloading Images
The procedure below describes how to download (copy) the images saved on a memory card 

in the camera to your computer, and display them on the main window. You can download 

images in the Tree View Area.

1 Create a folder to which images will be downloaded.

 From the menu that is displayed 

by clicking on the destination 

folder while pressing the <control> 

key, select [New folder] to create a 

folder and enter a name for the 

folder. (Enter [Photo] in the folder 

name field here as an example.)

2 Display a folder to be copied.

 Double-click the camera icon �

the [1] folder (CF card) or the [2] 

folder (SD card) � the [DCIM] 

folder.

 The [xxxEOSXXX] folder is 

displayed. 

3 Copy the folder to the hard disk.

 Drag and drop the [xxxEOSXXX] 

folder to the destination folder.

 The [xxxEOSXXX] folder is saved 

on your computer. 

xxx: A number between 100 and 999 is displayed.
XXX:The camera model connected to your computer 

is displayed.
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The following images can be displayed in EOS Viewer Utility.

• RAW and JPEG images shot on an EOS DIGITAL series (1D Mark II, 1Ds, 1D, 10D, D60, 

D30, DIGITAL REBEL/300D DIGITAL) camera

• TIFF and JPEG images saved in EOS Viewer Utility (M-45)

• DCF-compliant JPEG images

* Images that cannot be displayed appear as a question mark [?].

4 Click the copied folder.

 The images in the folder are 

displayed.

 Before disconnecting the camera 

from the computer, quit EOS 

Viewer Utility, set the camera’s 

power switch to <OFF>, and then 

disconnect the dedicated cable.

 You cannot display images in the preview window (M-20) or edit RAW images (M-29) 

saved on a memory card in the camera directly. Before working images with EOS 

Viewer Utility, be sure to download images saved on a memory card to your 

computer.

 For displaying images saved in a third-party card reader, follow the same procedure 

to download the target folder to your computer.

 The images that are processed on your computer after being shot or the images 

whose file name is changed may not be displayed properly.

 You cannot use the camera while displaying images on the camera.

 Images that were shot with the camera held vertically with [Auto rotate] setting to 

<ON> are automatically displayed vertically.

 If the selected folder contains a large number of images, there may be a short delay 

before the images appear.
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Handling the Folders
You can handle the folder on the menu that appears by clicking on the folder while holding 

down the <control> key.

The images are placed in the camera icon � the [1] folder (CF card) or the [2] folder (SD card) 

� the [DCIM] folder � the [xxxEOSXXX] folder. (“xxx” represents a number between 100 and 

999, and “EOSXXX” represents the camera model on which shots were taken.)

 The “****” in the file names represent the factory-set characters that are unique to each 

camera.

 The “YYYY” in file names represents four-digit numbers.

Click on the folder while holding down the <control> key, and then 

select an option from the menu that appears.

You can drag and drop folders from the Tree View Area to the other folders.

For JPEG images that were shot with Adobe RGB setting, the first character shows “_” 

(under bar) according to Exif 2.21 regulations.

Opens the selected folder.

Creates a new folder. Note that you 
cannot create a new folder in the 
memory card in the camera.

Allows you to change the folder name.

Memory Card Folder Structure and File Names

xxxEOSXXX

****YYYY.JPG (JPEG images, 
sRGB set for color space of matrix)

_***YYYY.JPG (JPEG images, 
Adobe RGB set for color space of matrix)

****YYYY.CR2 (RAW images)

DCIM1

CANONMSC

MISC2

The folder that holds the image control files 
in the DCIM folder.

The folder created when DPOF settings are set.
It folds the DPOF settings files.
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You can register frequent use folders as bookmark folders.

1 Display a folder to be registered (M-16).

2 Register a folder as a bookmark folder.

 Drag and drop the folder to be 

registered as shown on the right.

 The folder icon appears in the 

Bookmark area when it is 

registered.

 To delete the registered folder, 

click the folder while holding down 

the <control> key and select 

[Delete] from the menu that 

appears.

 You can also reorder the folders in the Bookmark area by dragging and dropping them.

 When you delete the registered folder, it just disappears from the Bookmark area. 

The actual data of the folder and the images in that folder will not be deleted.

Registering Frequent Use Folder
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Selecting the Image Display Mode
You can select the display size and method of images.  

Various information can be displayed with images. 

Double-clicking an image displayed on the main window can enlarge the image. 

When you change the processing parameters of RAW images, use this window.

 Up to six images can be displayed in the preview window at a time.

 A low resolution image is displayed first in the preview window, and then it changes to a high 

resolution image.

Preview window

Main Window (Thumbnail Display)

Digital exposure 
compensation value (M-31)

Protect mark (M-26)

This mark is displayed on 
protected images.

Recording quality
The [RAW] and [RAW+JPEG] 
symbols are displayed for RAW and 
RAW+JPEG images respectively. 
No symbol is displayed for JPEG 
images.

File name or shooting date/time

The items selected in the [Image Lower Display Item] list box in 
the [Preferences] dialog box (M-50) are displayed.

Sound recording mark (M-28)

This mark is displayed on images 
for which sound was recorded.

Check mark (M-24)

This mark is displayed on images 
for which a check mark was 
attached.

Preview Window Display 

RAW adjustment tool palettePreview tool bar
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Preview tool bar

* The above window shows all the information at once. In actual use, only the information 

needed is displayed.

You cannot display images in the preview window or edit RAW images (M-29) saved on 

a memory card in the camera directly. Before working images with EOS Viewer Utility, be 

sure to download images saved on a memory card to your computer.

For some images, it may take some time to change to the high resolution image.

Window button (M-25)

Display Size list 
box (M-22)

Select Next Image button (M-23)

Rotate right 90 degrees button (M-26)

Remove Check Mark button (M-24)

Remove protect button (M-26)

Save File button (M-45)

Erase images 
button (M-27)

Transfer images button (M-48)

protect button (M-26)

Add Check Mark button (M-24)

Rotate left 90 degrees 
button (M-26)

Select Previous Image 
button (M-23)

IPTC information button (M-51)

Display AF point button (M-22)

Play sound button (M-28)

Show/Hide Image Information button

Shows/hides the histogram, image information dispaly area, and comment input box.
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The AF point used when the shot was taken can be displayed.

Select a display size from the list box.

 In the main window, the available 

image sizes are [Small] (64  64

pixels), [Medium] (100  100

pixels), and [Large] (160  160

pixels).

 In the preview window, the 

available image sizes are [Fit to 

window] and [100%].

 When you select [100%], you can 

change the display position by 

dragging the image.

1 Display the image in the preview window (M-20).

2 Click the [Display AF point] button.

 The AF point is displayed.

 Clicking the button again hides the 

AF point.

When the shot was taken with automatic AF point selection, multiple active AF points 

might be displayed.

Selecting the Display Size

Main window

Preview window

Checking the AF Point
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Selecting Images

Click the target image.

 The frame around the selected 

image is colored.

 To select multiple images, hold 

down the <shift> key and click the 

images.

 To select sequential images, click 

the first image and then hold down 

the <option> + <shift> keys and 

click the last image.

Alternatively, you can use the arrow keys (����) on the keyboard to select images.

Click the target image.

 The selected image is displayed 

on the top window.

 When only one preview window is 

displayed, you can click the 

[Select Previous Image] button or 

the [Select Next Image] button to 

select the image to be displayed.

Selecting Images in the Main Window

Selecting Images in the Preview Window
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You can attach a check mark to the RAW image, allowing you to select images more easily.

This feature allows you to select multiple images in a single operation using conditions.

Click the [Add Check Mark] button.

 When the check mark is placed, 

the [ ] icon appears in the frame 

of the image.

 Clicking the [Remove Check Mark] 

button removes the [ ] icon from 

the frame of the image, and 

erases the check mark.

You cannot attach the check mark for any images other than RAW images.

 When multiple RAW images are selected, the check mark is attached to all the 

selected RAW images.

 Alternatively, you can perform the same operation using the menu that appears by 

holding down the <control> key and clicking.

Click the [Select Image] button and select the condition from the 

menu that appears.

 Only images that meet the 

condition are selected.

Attaching Check Marks to Images

Selecting Images by Condition
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You can set all the preview windows to the same size.

Select [Move main window to front] or [Move main window to 

back] from the menu that appears by clicking the [Window] 

button.

 The main window is brought/sent 

to the front/back of window stack.

1 Select the image whose size is the desired size (M-23).

2 Click [Standardize window size] from the menu that appears by 

clicking the [Window] button.

 All the displayed preview windows 

are set to the same size as the 

selected image.

Bringing/Sending the Main Window to the 
Front/Back of Window Stack

Equalizing the Display Sizes of the 
Preview Window
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Editing Images
You can edit all the images that can be displayed in EOS Viewer Utility.

You can protect important images to prevent them from being accidentally deleted.

You can rotate a selected image by 90-degree increments left or right.

When multiple images are selected, the edits are applied to all the selected images.

Click the [protect] button.

 When the image is protected, the  

[ ] icon appears in the frame of 

the image.

 Clicking the [Remove protect] 

button removes the [ ] icon from 

the frame of the image, and clears 

the protection.

 The [ ] is automatically displayed for images that were protected on the camera.

 Protection only prevents images from being deleted. Other types of image operations 

can still be performed for protected images.

 Alternatively, you can perform the same operation using the menu that appears by 

holding down the <control> key and clicking.

Click the [Rotate right 90 degrees] or [Rotate left 90 degrees] 

button.

 The image rotates 90 degrees in 

the selected direction.

 Images that were shot with the camera held vertically with [Auto rotate] setting to 

<ON> are automatically displayed vertically.

 If a rotated image is displayed in another application, the image may not appear 

rotated.

 Alternatively, you can perform the same operation using the menu that appears by 

holding down the <control> key and clicking.

Protecting Images

Rotating Images



Editing Images

M-27

M

3

W
o

rk
in

g
 w

it
h

 I
m

a
g

e
s
 i
n

 E
O

S
 V

ie
w

e
r 

U
ti
lit

y

You can move unnecessary images to the Trash on your computer and delete them.

You can check the information recorded with images and input comments.

1 Click the [Erase images] button.

 The images are moved to the 

Trash.

2 Select the [Finder] menu on the desktop � [Empty Trash].

 For OS 9, select the [Special] menu � [Empty Trash].

 The images are deleted.

 Images that you deleted by selecting [Empty Trash] in step 2 cannot be restored. 

Check carefully before deleting images.

 Protect important images (M-26) to prevent them from being accidentally deleted.

Alternatively, you can perform the same operation using the menu that appears by 

holding down the <control> key and clicking.

Image information display area
 The shooting information is displayed. 

The number of items displayed differs depending on the camera settings.
 You can copy the information as text data and paste it into another application.
 Clicking the [�] button can hide the detailed image information display area.

You cannot insert a hard return in the comment input box.

When multiple images are selected, the information from the image selected last is 

displayed.

Deleting Images

Checking the Image Information and Entering Comments

Comment input box
You can use this box to type in a comment 
up to 120 characters long.
Type in your comment and press the 
<return> key.
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Playing Back Sound
The sound recording mark is displayed for images for which sound was recorded.

You can use EOS Viewer Utility to print images in index format.

1 Select an image with [ ] displayed, and click the [Play sound] 

button.

 The [Audio Note] dialog box 

appears.

2 Adjust the sound with the buttons and slider.

1 Select images to be printed in index format (M-23).

2 Select the [File] menu � [Print Index].

 The Printer Setup dialog box appears.

3 Select the printer to be used, specify the print settings and print 

images.

Plays back the 
recorded sound.

Closes the dialog box.
Stops sound playback.

Indicates the sound playback position.
Pauses sound playback.

Click the [ ] button to resume.

Printing Images
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Editing RAW Images
You can specify the processing parameters for RAW images so that the RAW images are 

optimized for their intended purpose.

RAW images are processed based on the settings specified on the camera (including the 

processing parameters and white balance) and then displayed on the computer.

 When the following operations are performed, RAW images are processed and displayed:

• When the preview window is switched from the main window

• When the processing parameters are specified on the preview or main window

• When the image is converted to the TIFF or JPEG format and saved

• When the image is transferred to the specified retouching software

When the images are processed, it takes a while to display them.

 Approximate processing times

• The processing times given here are only approximations. Actual processing times 

vary widely depending on the images and the computer system.

• Processing times are based on Canon testing standards.

(OS: OS X (10.2); CPU: Power PC G4 700 MHz; RAM: 256 MB)

• The processing time in the retouching software includes starting up time of the retouching 

software (when using Adobe Photoshop 7.0).

Operation Details Processing Time

When the preview window is switched from the main window Approx. 14 sec.

When the image is transferred to the specified retouching 

software
Approx. 90 sec.

You cannot display images in the preview window (M-20) or edit RAW images saved on 

a memory card in the camera directly. Before working images with EOS Viewer Utility, be 

sure to download images saved on a memory card to your computer.

Processing RAW Images
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 You can specify the processing parameters in the RAW adjustment tool palette.

 This processing applies the specified parameters virtually and does not affect the original 

RAW images in any way. Consequently, you can redo the processing as often as you like 

with different parameters and then reset the modified parameters to the settings used when 

the shot was taken.

 Linear processing can be specified when an image is saved or is transferred to retouching 

software (M-46, M-49).

1 Display the RAW image in the preview window (M-20).

 If the RAW adjustment tool palette is hidden, select the [View] menu � [Tool palette] 

to show it.

2 Specify the processing parameters (M-31 to M-44).

 Clicking the [Reset to Shot Settings] button restores the settings to the values used 

when the shot was taken.

 If you click the [Preview] checkbox, the specified processing parameters are applied 

to the RAW images in real time.

3 Click the [Update] button.

 The RAW images are processed 

according to the specified 

processing parameters.

 The specified processing 

parameters are automatically 

saved in images.

 When multiple images are selected, the specified processing parameters are applied 

to all the selected RAW images.

 If you have specified processing parameters in the main window, even though you do 

not select the [Preview] checkbox, the specified processing parameters are applied to 

the images in real time.

Specifying the Processing Parameters
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You can adjust the brightness of an image in the range of +/–2 stops in 0.1-stop increments.

Drag the slider left or right to adjust the brightness. 

 The adjusted value is specified in 

the RAW adjustment tool palette.

Adjusting the Brightness (Digital Exposure Compensation)
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M-32

You can adjust the white balance in the images. You can then save white balance data on your 

computer (M-36) and register them on the camera (M-82).

Selecting the White Balance
You can select the white balance that is the closest to the light source when shots were taken.

Select the white balance from the list box.

White Balance Details
Color Temp.

K (Kelvin)

Auto Automatically adjusts the white balance. Approx. 3000 to 7000

Daylight For sunny daylight outdoors. Approx. 5200

Shade For shaded areas outdoors. Approx. 7000

Cloudy For cloudy or hazy days and during sunset. Approx. 6000

Tungsten For tungsten (light bulb) light. Approx. 3200

Fluorescent For fluorescent light. Approx. 4000

Flash When flash is used. Approx. 6000

Color Temp.
You can manually set color temperature for 

2800 to 10000K (in 100K increments) (M-33).
Approx. 2800 to 10000

 The selected white balance is specified in the RAW adjustment tool palette.

Adjusting the White Balance
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Specifying the Color Temperature
You can specify the color temperature to adjust the white balance.

1 Select [Color Temp.] from the list box.

2 Enter a color temperature.

 Enter the color temperature in the 

[Color Temp.] input box in the 

range of 2800K to 10000K (in 

100K increments).

 The entered color temperature is 

specified in the RAW adjustment 

tool palette.
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Click White Balance Function
You can automatically adjust the white balance simply by clicking a point in a white part of the 

image.

1 Click the [Click White Balance] button.

 When you move the cursor over 

the image, the cursor [ ] 

changes to [ ].

2 Click a point in a white part of the image.

 The white balance is adjusted so that the point clicked appears white.

 If you click on another point over the image, the white balance is adjusted again.

 To quit the click white balance, click the [Click White Balance] button.

 When you use Click White Balance Function, even though you do not select the 

[Preview] checkbox, the adjusted white balance is applied to the images in real time.

 When you use Click White Balance Function, [White Point] is displayed in the [White 

Balance] list box.
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Correcting the White Balance
You can correct the standard color temperature of the white balance. By using this function, you 

can obtain the effectiveness similar to the color temperature converting filter or color 

compensating filter (third-party product). The range of compensation is 9 levels for each color.

 This function is especially useful for users who understand the role and effect of the color 

temperature converting filter or color compensating filter.

Drag the slider left and right to adjust the white balance.

[LB Filter] slider:

Equates to the LB (Light Balancing) filter for color temperature conversion. Dragging 

the slider toward B-side adds blue hue, and toward A-side, amber hue.

[CC Filter] slider:

Equates to the CC (Color Compensation) filter for color correction. Dragging the slider 

toward G-side adds green hue, and toward M-side, magenta hue.

 The corrected value is specified in the RAW adjustment tool palette.

One level of blue/amber hue is equal to five mireds of the color temperature converting 

filter. (Mired: the unit of the density of the color temperature converting filter)

Correction value when shooting.

The corrected value specified using the slider.
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You can save the adjusted white balance data on your computer and then register them on the 

camera as the personal white balance settings (M-82).

1 Adjust the white balance (M-32 to M-35).

2 Click the [Save White Balance Settings] button.

 The [Save] dialog box appears.

3 Select the destination folder, enter the file name, and then click 

the [Save] button.

 The white balance data is saved.

Windows/Macintosh compatibility for white balance data

White balance data saved on your computer is compatible with EOS Viewer Utility for 

both Windows and Macintosh.

Saving the White Balance
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You can use the tone curve to adjust the colors and brightness. You can then save the adjusted 

tone curve on your computer (M-39) and register it on the camera (M-80).

1 Click the [Adjust Tone Curve] button.

 The [Tone Curve] dialog box 

appears.

2 Select the channel from the list box.

Adjusting the Color and Brightness (Adjust Tone Curve)

Tone Curve

Input box Output box

Read button (M-39) Save button (M-39)

Apply button

Tone curve settings 
list box

Shot Settings button

Restores the image to its original 
condition when shots were taken.

Adjusts all the channels.

Adjusts the red channel.

Adjusts the green channel.

Adjusts the blue channel.
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M-38

3 Adjust the tone curve.

 Click the tone curve to show []

and drag it to a desired location.

Horizontal axis: Input level

Vertical axis: Output level

 To delete [], select [] and then 

press the <delete> key on the 

keyboard.

 Up to four of [] can be shown.

 Alternatively, you can adjust the 

tone curve by selecting [] on the 

tone curve and entering values 

directly into the [Input] / [Output] 

box.

4 Click the [Update] button on the RAW adjustment tool palette.

 The adjusted tone curve is applied 

to the image.

 While checking the adjusted tone 

curve, repeat steps 2 and 4 to 

make further adjustments.

5 Click the [Apply] button.

 The [Tone Curve] dialog box 

closes.

Windows/Macintosh compatibility for tone curve data

Tone curve data saved on your computer is compatible with EOS Viewer Utility for both 

Windows and Macintosh.
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Saving the Tone Curve
You can save the adjusted tone curve.

Loading the Tone Curve
You can apply the saved tone curve to other images.

1 Adjust the tone curve (M-37).

2 Click the [Save] button.

 The [Save] dialog box appears.

3 Select the destination folder, enter the file name, and then click 

the [Save] button.

 The tone curve is saved.

1 Click the [Read] button.

 The [Choose a File] dialog box 

appears.

2 Open the folder that containing the tone curve, select the file, and 

then click the [Choose] button.

 The tone curve is loaded.

3 Click the [Update] button on the RAW adjustment tool palette.

 The tone curve is applied to the image.
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Tone Curve
A tone curve shows the brightness and color saturation for the original image (input) and the 

adjusted image (output) in the form of a line graph. You can use the tone curve to adjust the 

image brightness and color saturation values that were set by the camera automatically when 

the shot was taken.

The tone curve adjustment options include [RGB], which adjusts the input and output for the 

entire image in a single operation, as well as the [Rch], [Gch] and [Bch] settings that adjust 

each color individually. You can use the [Tone curve settings] list box to switch between the 

different channels as you make your adjustments.

The horizontal axis shows the brightness and color saturation for the unadjusted (input) image, 

with the left-hand end indicating shadow (darker areas of the image) and the right-hand end 

indicating highlights (brighter areas of the image).

The vertical axis shows the brightness and color saturation for the adjusted (output) image, with 

the lower end indicating shadow and the upper end indicating highlights.

You can adjust the contrast of an image.

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.

Selecting the Contrast
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]

Use the procedure below to select the film-equivalent hue, chroma and color range (the range 

of colors that can be reproduced).

1 Click the [Standard] tab.

 The [Standard] tab sheet appears.

2 Select the color matrix from the list box.

Selecting the Color Matrix
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Settings of Color Matrix

Color Matrix Details

1 Standard
Reproduces the natural color saturation and tones.

Effective for reproducing the subject’s natural color tones.

2 Portrait
Reproduces the color tones suited to portraits.

Effective for reproducing beautifully natural skin tones.

3 H-saturat.

Reproduces the color saturation similar to that in high-chroma color slide 

film.

Effective for reproducing clear and vivid color tones.

4 Adobe RGB

Processes images so that the color space is compatible with Adobe RGB.

Mainly used for printing for business purpose.

Not recommended for users who do not have a knowledge of image 

processing and Adobe RGB DCF 2.0 (Exif 2.21). With a printer that does 

not support the sRGB computer environments or DCF 2.0 (Exif 2.21), the 

images are printed with moderate color tone. So, you need to process the 

images after shooting.

5 L-saturat.
Reproduces low color saturation.

Effective for making color tone moderate.

 The selected color matrix is specified in the RAW adjustment tool palette.

Color Matrix Color Space Color Saturation Color Tone

1 Standard sRGB Standard 0

2 Portrait sRGB Standard -2

3 H-saturat. sRGB Dark 0

4 Adobe RGB Adobe RGB Standard 0

5 L-saturat. sRGB Dark 0

You can attach the ICC profile to the image (M-45).



Editing RAW Images

M-43

M

3

W
o

rk
in

g
 w

it
h

 I
m

a
g

e
s
 i
n

 E
O

S
 V

ie
w

e
r 

U
ti
lit

y

Use the procedure below to specify the color saturation, color tone, and color space for the 

image.

1 Click the [Advanced] tab.

 The [Advanced] tab sheet 

appears.

2 Select the settings from the list boxes.

 The selected setting is specified in the RAW adjustment tool palette.

Selecting a negative value for [Color Tone] makes the color tone reddish, and a positive 

value, yellowish.

Adjusting the Color

[–2] strongly adjusts the colors 
so that skin tones appear 
redder while [–1] makes the 
same adjustment less strongly.
[0] applies the standard color 
matching adjustment.
[+2] strongly adjusts the colors 
so that skin tones appear 
yellower while [+1] makes the 
same adjustment less strongly.
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You can adjust the edge sharpness of an image.

Select an adjustment value from the list box.

 Higher values give higher levels of 

edge sharpening.

 The selected adjustment value is 

specified in the RAW adjustment 

tool palette.

Selecting the Sharpness
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Saving Images
You can convert and save RAW images to TIFF or JPEG images, and save JPEG images as 

another name. When you convert RAW images to the TIFF format and save them, the specified 

color space data (M-41 to M-43) is attached to each of images as the ICC profile automatically.

ICC stands for International Color Consortium.

1 Select images to be saved (M-23).

2 Click the [Save File] button and select [Convert and save in file] 

from the menu that appears.

 The [Save File] dialog box 

appears.

3 Specify the settings and click the [OK] button.

 The images are saved in the 

selected folder.

When you convert RAW images to the TIFF images and save them, the ICC profile is 

attached to each of images automatically.

When you wish to display the images with the ICC profile attached in the retouching 

software, it is recommended that you should use the software that supports the ICC 

profile reproducing more faithful colors.

Restores the settings to 
their original ones and 
closes the [Save File] 
dialog box.

Applies the settings 
and saves the image.
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The image is saved as a new image in the same folder as the selected image.

Allows you to specify the folder 
in which the image will be saved.

Select a setting for [Quality] (compression ratio) when you have selected [JPEG] from 
the list box, from [4 (Highest image quality)] through [1 (High compression ratio)]. 
Higher values give higher quality of the JPEG image.

Specify the resolution for saving images in a range of 
10 to 2000 pixels/inch.

If you click this checkbox, the JPEG images that were 
taken in the RAW+JPEG format are also to be saved.

If some of the images to be saved are RAW images, select [Do not convert], [JPEG], or [TIFF] for the 
conversion format. If you select [TIFF], you can select the number of bits used when you save images, from 
[8bit/ch], [16bit/ch] and [16bit/ch linear]. If you select [JPEG], the images are saved in the [8bit/ch] format.
The extensions used for the saved files are shown below.

Conversion Format Extension

Do not convert .CR2

JPEG (8bit/cn) .JPG

TIFF (8bit/cn) .TIF

TIFF (16bit/ch, 16bit/ch linear) .TIF

When the [Save in following specified folder] radio 
button has been selected, this button allows you to 
specify the folder in which the image will be saved. 
The name of the destination folder is displayed 
next to the [Browse] button.
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Alternatively, you can perform the same operation using the menu that appears by 

holding down the <control> key and clicking.

Click this checkbox when you want to save the image without changing the name.

This is text inserted before the file number. You can enter up to 12 characters. 
When you enter text, an example appears in the [Example] field below the text box.

When the image files to be saved include 
images with sound, this option can save 
the sound files with the respective images.

Enter the number of digits in the sequential number 
that attaches to the file and the starting number 
used. A maximum of 9 digits can be specified.

Click this checkbox when saving the file after converting a RAW image to a 
JPEG image or TIFF image adds one of the following at the end of the file name.

Conversion Format File Name

JPEG RJ

TIFF (8bit/ch) RT8

TIFF (16bit/ch, 16bit/ch linear) RT16, RT16L
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Transferring Images to Retouching Software
You can transfer the images displayed in EOS Viewer Utility to retouching software.

The descriptions given here use Adobe Photoshop 7.0, as an example.

 In order to transfer images, you will need retouching software such as Adobe 

Photoshop.

 Be sure to specify the image transfer settings before transferring images.

1 Click the [Transfer images] button.

 The [Transfer Images] dialog box 

appears.

2 Click the [Browse] button.

 The [Select application] dialog box 

appears.

3 Select the retouching software (Photoshop 7.0) to which the 

image will be transferred.

 Select the drive in which 

Photoshop 7.0 is installed � the 

[Adobe Photoshop 7] folder �

[Adobe Photoshop 7]. Then click 

the [Choose] button.

 Photoshop is specified and the 

dialog box closes.
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4 Select the radio button and then select a folder in which the 

images to be transferred will be saved.

5 Specify [Output settings] and [File name] and then click the [OK] 

button.

 See “Saving Images” (M-45) for the procedure for specifying [Output settings] and 

[File name]. 

 Photoshop starts up and displays the transferred images.

 The transferred images are saved in the folder that you have selected in step 4.

 It is recommended that you should use the retouching software (third-party product) 

that supports 16-bit images for the one to be specified for the transfer image function.

 When you convert RAW images to the TIFF format and save them, the specified color 

space data (M-41 to M-43) is attached to each of the images as the ICC profile 

automatically.

 Alternatively, you can perform the same operation using the menu that appears by 

holding down the <control> key and clicking.

The images to be transferred are 
saved as new images in the same 
folder.

Click the [Browse] button and then select a folder in which the images 
to be transferred will be saved.
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Specifying the Preferences
You can make various settings for transferring images, the information displayed with thumbnail 

images, and the image resolution for converting RAW images to other formats.

1 Select the [EOS Viewer Utility] menu � [Preferences].

 The [Preferences] dialog box appears.

2 Specify the settings and click the [OK] button.

 The settings are applied and the [Preferences] dialog box closes.

Allows you to select whether the folder that was open the last time is displayed or 
the specified folder is always displayed when EOS Viewer Utility starts up.

Select the information to be displayed below images, 
from [File Name] and [Shooting Date/Time].

Restores the settings to 
their original ones and 
closes the [Preferences] 
dialog box.

Applies the settings and closes 
the [Preferences] dialog box.

Restores the settings to 
the default settings.
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Setting the IPTC Information
IPTC stands for International Press Telecommunications Council and refers to a standard for 

communications and information exchange tags attached to images. The standard was 

established by newspaper and communications companies to allow problem-free transmission 

of images.

You can attach this IPTC information to JPEG images, or to TIFF and JPEG images that were 

converted from RAW images and saved with EOS Viewer Utility. You can also save the IPTC 

information on your computer, and then load the saved information and apply it to other images.

1 Select a JPEG image (M-23).

2 Click the [IPTC information] button.

 The [IPTC information] dialog box 

appears.

3 Enter information (M-52, M-53).

 Select any of [IPTC-1], [IPTC-2], or [IPTC-3] tab to display the tab sheet, and enter 

the information.

 The entered IPTC information can be saved on the dialog box that appears by 

clicking the [Save As] button.

 The saved IPTC information can be loaded on the dialog box that appears by clicking 

the [Read] button.

4 Click the [Save] button.

 The specified IPTC information is applied to the image.

5 Click the [OK] button.

 The [IPTC information] dialog box closes.

Windows/Macintosh compatibility for IPTC information settings data

IPTC information settings data saved on your computer is compatible with EOS Viewer 

Utility for both Windows and Macintosh.
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Settings on the [IPTC-1] tab sheet 

IPTC-2 tab IPTC-3 tabIPTC-1 tab
Loads the IPTC information saved on your computer.

Saves the entered IPTC information on your 
computer.

Cancels the entered IPTC information.

Displays the image for which you will enter 
the IPTC information.

When multiple images are selected, 
this button displays the IPTC 
information for the previous image.

When multiple images are selected, 
this button displays the IPTC 
information for the next image.

Displays the image No. in a sequence.

Closes the [IPTC information] dialog box.

Displays the IPTC information entered before 
the [Previous] or [Next] button was clicked.

Applies the entered IPTC information to the image.

You can enter up to 64 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 2000 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.
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Settings on the [IPTC-2] tab sheet 

Settings on the [IPTC-3] tab sheet 

You can enter up to 10 characters.

Select [Highest Priority (=1)], [Normal (=5)], or 
[Low Priority (=8)] from the list box.

You can enter up to 256 characters.

You can enter up to 8 characters.

You can enter up to 11 characters.

You can enter up to 32 characters.

You can enter up to 3 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 256 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.
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Merging Images with PhotoStitch
You can merge multiple JPEG images to create a panorama shot.

1 Double-click the [Canon Utilities] folder � the [PhotoStitch] folder 

� the [PhotoStitch Launcher] icon.

 [PhotoStitch Launcher] appears.

2 Click the [Merge Images] button.

 PhotoStitch starts up.

 Follow the instructions in the guidance window to merge the images.

 Please refer to the PhotoStitch Help menu for more details.

 You cannot merge RAW images in PhotoStitch.

 Up to four images can be merged using PhotoStitch.
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Specifying Camera 

Settings in EOS 

Viewer Utility

This chapter describes how to specify the owner’s name and date/time, the 

Personal Functions, the Parameters, and the Personal White Balance in 

the camera.
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Specifying the Camera Settings
You can specify the owner’s name and date/time, the personal functions, the processing 

parameters, and the personal white balance, etc. in the camera.

1 Connect the camera to your computer (M-8).

2 Start up EOS Viewer Utility (M-12).

3 Click the [Camera Settings] button.

 The [Camera settings] dialog box 

appears.

4 Select a tab and specify the camera settings.

Sets up to 26 Personal Functions and 
applies the settings to the camera (M-58).

You can specify owner’s name and shooting 
date/time on the camera, and check the 
camera properties data and the status of the 
battery and the memory card (M-57).

Specifies parameters (M-78), tone curve (M-80),
personal white balance (M-82), color matrix (M-84),
and JPEG quality (M-86) on the camera.
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Basic Settings
You can specify the owner’s name and date/time in the camera, and check the properties of 

a memory card (CF card, SD card) in the camera.

1 Display the [Camera settings] dialog box (M-56).

2 Select the [Basic settings] tab.

 The [Basic settings] tab sheet 

appears.

3 Specify the basic settings.

4 Click the [OK] button.

 The settings are applied and the [Camera settings] dialog box closes.

The battery level of the 
camera is indicated by 
[ ] or [ ]. When 
you are using the DC 
Coupler Kit, [ ] is 
displayed.

This box shows whether a 
memory card is loaded in 
the camera along with the 
available space on the 
card and its total capacity.

Applies the settings that 
you have specified in the 
[Basic settings] tab sheet 
to the camera. Restores the parameters to their 

original ones and closes the [Camera 
settings] dialog box.

Applies the settings that you have specified 
in all the tab sheets to the camera and 
closes the [Camera settings] dialog box.

Enter the name of a 
camera owner. You can 
enter up to 31 characters.

Enter a value or click the 
[�]/[�] buttons to specify 
the date and time.

Imports the date and time 
from your computer.

This box shows the 
camera model, body ID 
(serial number) and 
firmware version.



M-58

Personal Function Settings
You can set up to 26 Personal Functions tailored to different types of photography and apply 

those function settings to the camera. You can also save the specified settings on your 

computer and load the saved settings.

1 Display the [Camera settings] dialog box (M-56).

2 Select the [Personal functions] tab.

 The [Personal functions] tab sheet 

appears.

3 From the list box, select a window in which you wish to specify 

settings.

 The selected window appears.

 In the [Combination] window, you can check the specified personal function settings 

and the status of whether or not the settings are applied to the camera. You can also 

save and load the personal function settings (M-75).

Loads the details of the Personal Functions 
that have been specified on the camera.

Restores the parameters to their original ones and closes 
the [Camera settings] dialog box.

Applies the settings that you 
have specified in the 
[Personal functions] tab sheet 
to the camera.

Applies the settings that you have specified in all 
the tab sheets to the camera and closes the 
[Camera settings] dialog box.

Removes all the check marks from the 
windows.
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You can specify the Personal Function settings listed below in the different windows.

[Exposure functions 1]

Disables the shooting modes (M-62)

Disables the metering modes (M-62)

[Exposure functions 2]

Specifies the metering mode for manual exposure (M-63)

Sets the maximum and minimum shutter speeds to be used (M-63)

Sets the maximum and minimum apertures to be used (M-64)

[Exposure functions 3]

Registers and switches the shooting mode and metering mode (M-64)

Repeats bracketing during continuous shooting (M-66)

Sets the number of shots to be bracketed (M-66)

Changes the bracketing sequence for C.Fn-09-2/3 to increased exposure, 

standard exposure, and decreased exposure (M-66)

Retains the shift amount for program shift (M-67)

[AF functions]

Disables focus detection (search driving) by the lens drive (M-68)

Disables the AF-assist beam from being emitted (M-68)

Enables automatic shooting when focus is achieved at the fixed point of focus while 

the shutter button is pressed fully (M-69)

Disables automatic AF point selection (M-69)

Enables automatic AF point selection when C.Fn-11-2 has been set (M-70)

[Drive functions]

Sets the continuous shooting speed (M-70)

Limits the number of shots during continuous shooting (M-70)

Enables quiet operation when the shutter button is OFF after picture-taking (M-71)
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[Other functions 1]

Changes the timer’s time length (M-71)

Illuminates the LCD panel during bulb exposures (M-72)

[Other functions 2]

Sets the default settings when the CLEAR button is ON (M-72)

[Other functions 3]

Shortened release time lag (M-73)

Enables the electronic dial’s function to be used in the reverse direction (M-73)

Prevents exposure compensation with the Quick Control Dial (M-73)

Enables Quick Control Dial switch to turn on/off Main Dial too (M-73)

Add original decision data (M-74)

[Combination]

Allows you to check the settings (M-75)

Allows you to save the settings (M-76)

Allows you to load the saved settings (M-76)

* Omission of P.Fn-11, 12, 13, 22 and 29

To match the numbers and descriptions for the Personal Functions to the EOS-1 series, some 

numbers have been omitted.
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4 Set up the Personal Function (M-62 to M-74).

 If you select the checkbox, the selected item takes effect.

 If you enter a numerical value, values outside the valid range of settings are ignored.

 Clicking the [Load settings] button acquires the settings with the Personal Function 

settings on the camera.

 Clicking the [Reset] button removes all the check marks from the windows.

 If the Personal Function settings are saved on your computer, the saved settings can 

be loaded (M-76).

5 Check the settings and save them on your computer if necessary 

(M-75, M-76).

6 Click the [OK] button.

 Applies the settings and closes the [Camera settings] dialog box.

 When a Personal Function is 

applied to the camera, < > 

appears on the LCD panel.

Checkbox
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 The  shown in this section provides brief descriptions of the Custom Function Settings 

for the respective camera functions. For more details, refer to “Custom Function Settings” in 

the camera’s Instruction Manual.

Disables the shooting modes

 Click the shooting modes you do not want to use.

 Unwanted shooting modes can be skipped while you are selecting the shooting mode.

 This makes selecting the desired shooting mode faster.

Disables the metering modes

 Click the metering modes you do not want to use.

 Unwanted metering modes can be skipped while you are selecting the metering mode.

 This makes selecting the desired metering mode faster.

At least one checkbox must be left unchecked.

At least one checkbox must be left unchecked.

Description of Personal Functions
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Specifies the metering mode for manual exposure

 Select the metering mode to be specified.

 You can specify the metering mode to be used in the manual exposure mode. 

 When you set the manual exposure mode, the metering mode selected here will be set 

automatically. In the manual exposure mode, this enables you to use a metering mode 

different from the one used in the AE modes. 

Sets the maximum and minimum shutter speeds to be used

 Select the maximum and minimum shutter speeds from the list box.

 For example, if you set 1/2000 sec. as the fastest shutter speed and 1/60 sec. as the 

slowest, the shutter speed range will be 1/2000 to 1/60 sec.

 This makes shutter speed selection faster and prevents a slow-speed sync. in aperture-

priority AE mode with the flash.

If you set the maximum and/or minimum shutter speed to one that is not a full-stop 

increment (such as 1/750 sec.), the controllable and settable shutter speed range might 

not be as exact as you set it. (A slight deviation may occur.) This applies if you also set 

Custom Function C.Fn-6-1 and C.Fn-6-2 and set the maximum and/or minimum shutter 

speed to one that is not a full-stop increment (such as 1/3200 sec.).

 To ensure that a proper flash sync speed is set in the Program AE mode, a shutter 

speed range of 1/200 sec. to 1/80 sec. cannot be set.

 If safety shift has been enabled (with C.Fn-16), it will override P.Fn-04’s shutter speed 

range.
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Sets the maximum and minimum apertures to be used

 Select the maximum and minimum apertures from the list box.

 For example, if you set 1.4 for the largest aperture and 8.0 for the smallest aperture, the 

usable aperture range will be f/1.4 to f/8.0.

 You can better control the apertures used by setting the range of usable apertures.

Registers and switches the shooting mode and metering mode

 While you press the <  > button, you can select the preset shooting mode, exposure 

setting (such as the aperture for aperture-priority AE), metering mode, and exposure 

compensation amount.

 Select settings that are appropriate for each shooting mode.

 The modes and settings are preset with the camera.

See “Registering the Modes and Settings with the Camera” for information on the camera 

procedures (M-65).

 Convenient when you want to instantly select the preset modes and settings to suit a 

particular shooting situation such as backlit or front-lit conditions.

 Specify a minimum aperture value that is smaller than the maximum aperture setting. 

If you select a minimum aperture value that is larger than the maximum aperture, a 

warning message appears and the setting reverts to the default value.

 If you set the maximum and/or minimum aperture to one that is not a full-stop 

increment (such as f/4.5), the controllable and settable aperture range might not be 

as exact as you set it. (A slight deviation may occur.) This applies if you also set 

Custom Function C.Fn-6-1 or C.Fn-6-2 and set the maximum and/or minimum 

aperture to one that is not a full-stop increment (such as f/6.3).

 If the largest aperture of the attached lens is smaller than the largest aperture you set 

with P.Fn-05, the largest aperture will be set to the largest aperture of the lens. And if 

the smallest aperture of the attached lens is larger than the smallest aperture you set 

with P.Fn-05, the smallest aperture will be set to the smallest aperture of the lens.

 If safety shift has been enabled (with C.Fn-16), it will override P.Fn-05’s aperture 

range.
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Registering the Modes and Settings with the Camera (  )

1 Set the shooting mode and shooting mode settings (aperture 

setting for aperture-priority AE mode). Then set the metering 

mode and exposure compensation amount.

2 Register the modes and settings.

 First press the <  > button, then 

press the <  > button.

 <  > appears in the LCD panel, 

indicating that the modes and 

settings have registered.

 The registered modes and 

settings can be modified any 

number of times.

To register the modes and settings, first press the <  > button before the <  > 

button. If you press the <  > button first, the camera will only select the registered 

modes and settings instead.

 Bulb cannot be preset.

 You cannot select the registered modes and settings during continuous shooting.

 If P.Fn-03 has been set to specify the metering mode for manual exposure, and  P.Fn-

06 is used to register the manual exposure mode and a metering mode different from 

the one specified with P.Fn-03, you can select the metering mode specified with P.Fn-

03 by pressing the <  > button.

 If P.Fn-04 and/or P.Fn-05 has been set, set the shutter speed and aperture within the 

range specified with P.Fn-04 and/or P.Fn-05.

 If the shooting and metering modes you want to set are excluded by the restrictions in 

P.Fn-01 and P.Fn-02, those Personal Functions must be disabled. For information on 

clearing and resetting Personal Functions, refer to “Clearing and Resetting Personal 

Functions” in the camera’s Instruction Manual.

 Even if the shooting and metering modes selected by P.Fn-06 are excluded by the 

restrictions in P.Fn-01 and P.Fn-02, they are still valid for P.Fn-06.

 If C.Fn-4-1 or C.Fn-4-3 has been set, AF and AE will also take effect when you 

press the <  > button.

 When C.Fn-18 is set, P.Fn-06 is disabled.
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Repeats bracketing during continuous shooting

 While you hold down the shutter button, bracketing repeats continuously in the currently 

selected drive mode.

 This function is useful when you want to continuously repeat the bracketing sequence.

Sets the number of shots to be bracketed

 Select the number of shots from the list box.

 The usual 3-frame bracketing is changed to 2-, 3-, 5-, or 7-frame bracketing.

 In bracketing shots, if you select 5-frame bracketing with 1-stop increment, the bracketing 

for the shots is –2, –1, 0, +1 and +2.

 This function is useful for adjusting the range of bracketing.

Changes the bracketing sequence for C.Fn-09-2/3 to increased 

exposure, standard exposure, and decreased exposure

 The bracketing sequence when C.Fn-09-2/3 is selected (decreased exposure � standard 

exposure � increased exposure) changes to increased exposure � standard exposure �

decreased exposure.

 This function is useful when you want to start the bracketing sequence with a increased 

exposure frame.

 Even when the setting is outside the bracketing level display range, the exposure is 

compensated as specified.

 This function can be used in combination with C.Fn-09-2/3 and P.Fn-09.

This function can be used in combination with P.Fn-08.
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Retains the shift amount for program shift

 Normally, any program shift amount is canceled after you take the picture. This Personal 

Function retains the program shift amount.

 This function is useful when you want to shift the standard program line so that priority is 

given to the shutter speed or to the aperture.

By shifting the program, you can change the shutter speed or aperture and still retain the same 

exposure level. Under the same brightness, you can shift the program line toward the right to 

set a faster shutter speed and a larger aperture (lower f/number). Or you can shift the program 

line toward the left to set a slower shutter speed and a smaller aperture (higher f/number).

P.Fn-10 retains the amount of program shift. Select the appropriate amount of shift for the level 

of priority you want to give to the shutter speed or aperture setting.

 The program shift amount remains in effect until you set it back to the standard program 

manually or replace the battery or press the CLEAR button (QUALITY+WB).

 The shift amount is retained even after you change the lens.
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Disables focus detection (search driving) by the lens drive

 Normally, when you press the shutter button halfway and focus cannot be achieved, the lens 

is driven to search the correct focus. This lens driving operation can be turned off.

 When focus has been achieved once and refocusing fails, the subsequent lens driving 

operation can result in grossly inaccurate focus. This subsequent lens driving operation is 

turned off. P.Fn-14 is especially suited for super telephoto lenses.

Disables the AF-assist beam from being emitted

 This disables the external Speedlite’s built-in AF-assist beam.

 At a joint photo session, etc., this prevents the AF-assist beam’s pattern projected on the 

subject from being photographed by other photographers.

If autofocusing is attempted while the lens is way out of focus, the lens may stop 

operating. Focus manually until the subject outline becomes discernable, then 

autofocus.
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Enables automatic shooting when focus is achieved at the 

fixed point of focus while the shutter button is pressed fully

 This takes the picture automatically when the subject comes to the preset focusing distance. 

Focusing detection is performed using the selected AF point.

 Set the lens focus mode switch to <MF> and focus manually at the desired point of focus.

 Keep pressing the shutter button fully.

 Using an accessory like Remote Controller RS-80N3 which can lock the shutter button 

relieves you from holding down the shutter button while you wait for the subject.

Disables automatic AF point selection

 When you select beyond the peripheral AF point, the selection stops there. It makes 

selecting a peripheral AF point faster.

 Because the camera remains on standby while the shutter button is fully pressed, 

battery power is used up more quickly. For long periods of photography, use the DC 

Coupler Kit.

 When this function is used in combination with a flash, the flash remains on standby 

at full charge. Consequently, the flash batteries are used up more quickly. (The 

Speedlite’s SE mode is disabled.)

 When you use a flash with this function, set the drive mode to single-frame shooting. 

If you select continuous shooting, the flash will be unable to charge in time for 

successive shots and will not fire at full charge.

 If you set the drive mode to continuous shooting, set the number of shots in P.Fn-20. 

If you do not use P.Fn-20, once the camera focuses on the subject, continuous 

shooting will continue until the capacity of the memory card is reached.

 P.Fn-16 cannot be used with manual focus lenses or with lenses that are too slow to 

be used with autofocusing.

 Do not use this function when C.Fn-4-1/3 is set as shots will be taken regardless of 

whether the image is in focus.

Using an accessory like Remote Controller RS-80N3 which can lock the shutter button is 

recommended.

 If C.Fn-11-2 has been set, you can switch to automatic AF point selection by pressing 

the <  > button during autofocusing. (� “Selecting the AF Point” in the camera’s 

Instruction Manual)

 If automatic AF point selection has been preset at [AF frame registration] setting, the 

preset setting remains valid. (� “Registering and Switching the AF Point” in the  

camera’s Instruction Manual)
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Enables automatic AF point selection when C.Fn-11-2 has been 

set

 Enables the standard horizonal AF point selection together with automatic AF point 

selection with C.Fn-11-2.

 Convenient when you want to use automatic AF point selection while C.Fn-11-2 has been 

set.

Sets the continuous shooting speed

 In the list box, select the speed of continuous shots during continuous shooting.

 By reducing the maximum continuous shooting speed, AI Servo AF continuous shooting can 

be more stable.

Limits the number of shots during continuous shooting

 This enables you to enter the maximum number of shots to be exposed during continuous 

shooting while the shutter button is pressed fully.

 Convenient when you do not want to shoot an unwanted scene that follows.

If P.Fn-17 [Disables automatic AF point selection] has also been set, P.Fn-17 will 

override P.Fn-18 to disable automatic AF point selection.

In AI Servo AF, it may not be possible to complete the selected speed of continuous 

shots.
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Enables quiet operation when the shutter button is OFF after 

picture-taking

 When single-frame shooting is selected, this function selects quiet camera operation when 

you release the shutter button from the fully pressed position to the half way position.

 This is useful when the camera operation noise would be disturbing after you take the 

picture.

Changes the timer’s time length

 After you press and release a button, the respective function remains active for a specific 

number of seconds. You can change this number of seconds as necessary.

 The function’s activation time can be set from 0 to 3600 sec. (1 hour).

 If the standard activation time is too short or too long, you can adjust it.

If you select continuous shooting, the camera operates normally.

Setting mirror lockup with C.Fn-12 will further reduce the shooting noise.

6 sec. Timer  After you press the shutter button halfway or the <  > button.

16 sec. Timer  FE lock time after you press the <  > button.

Post-shutter

release timer

 Exposure setting retaining time after the picture is taken. Setting 

this to a longer time can make it easier to shoot with AE lock.

 LCD panel illumination time after the picture is taken.

Be aware that a longer activation time will consume more battery power. The battery life 

will become shorter and fewer number of shots can be taken with the battery.

To turn off the function’s activation time midway, press the <  > button, <  > 

button or <  > button.
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Illuminates the LCD panel during bulb exposures

 After the bulb exposure starts, press the <LCD panel illumination> button to illuminate the 

LCD panel until the bulb exposure ends.

 Convenient when you want to monitor the elapsed bulb exposure time.

Sets the default settings when the CLEAR button is ON

 You can use this function to select the default mode selected when you press the CLEAR 

button <QUALITY+WB>.

 Convenient when you want to instantly switch to frequently-used settings.

Taking bulb shots for long periods speeds up battery charge depletion and reduces the 

number of available shots.
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Shortened release time lag

 Normally, the shutter-release time lag is controlled for stability. This Personal Function 

eliminates this control. As a result, the shutter-release time lag can be reduced by as much 

as about 20 percent when the aperture needs to be stopped down by no more than 3 stops.

 This is effective when a shorter shutter-release time lag is more important than a stable 

shutter-release time lag.

Enables the electronic dial’s function to be used in the reverse 

direction

 The electronic dial’s rotational function can be reversed for selecting the AF point and 

setting the shutter speed and aperture.

 By matching the dial’s rotation direction to the particular operation, the operation can feel 

more intuitive.

Prevents exposure compensation with the Quick Control Dial

 The Quick Control Dial cannot be used to set exposure compensation.

 This prevents exposure compensation from being set accidentally while the AF point is 

being selected.

Enables Quick Control Dial switch to turn on/off Main Dial too

 Setting the Quick Control Dial switch to <OFF> disables the Main and Quick Control Dials.

Since the difference is in 10-millisecond increments, the time lag may not feel any 

shorter.

When the main dial’s rotational function is reversed, the horizontal AF point selection 

direction does not change.
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Add original decision data

 The data that shows whether or not the image is the original one can be added to the image.

When selecting the display format of Shooting information (INFO), the icon showing the 

captured image with Original image verification data is displayed.

For more details, refer to “Shooting Information Display” in the camera’s Instruction Manual.

 For the decision of the original image, you will need the dedicated accessory (optional).

The original decision data cannot be added to the JPEG or TIFF image converted from 

the RAW image.
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You can check the specified personal functions and the status of whether or not the settings are 

applied to the camera. You can also save the settings on your computer and then load the 

saved settings and apply them to the camera.

1 Specify the personal functions (M-62 to M-74).

2 Select [Combination] from the list box.

 The [Combination] window 

appears.

3 Check the settings, save and load them (M-76).

 You can check the Personal Function settings and check if these settings are applied 

on the camera.

Checking, Saving, and Loading Personal Function Settings
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Saving the Settings

Loading the Settings

1 Click the [Save as] button.

 The [Save] dialog box appears.

2 Select the destination folder, enter the file name, and then click 

the [Save] button.

 The specified Personal Function settings are saved.

To update an existing file, click the [Save] button.

1 Click the [Open] button.

 The [Open] dialog box appears

2 Open the folder containing the settings, select the file, and then 

click the [Open] button.

 The Personal Function settings data saved in that file are loaded.

Windows/Macintosh compatibility for Personal Function settings data

Personal Function settings data saved on your computer is compatible with EOS Viewer 

Utility for both Windows and Macintosh.
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Shot Settings
You can specify various shot settings, such as processing parameters, tone curve, personal 

white balance settings, color matrix, and JPEG quality, and then apply these settings to the 

camera.

1 Display the [Camera settings] dialog box (M-56).

2 Select the [Shoot settings] tab.

 The [Shoot settings] tab sheet 

appears.

3 Click one of the buttons to display each dialog box.

4 Click the [OK] button.

 The settings are applied to the camera and the [Camera settings] dialog box closes.

Allows you to select tone 
curves, specify the sharpness 
and contrast, and then register 
these settings on the camera 
(M-78).

Loads the saved tone curves, 
and allows you to select color 
channels and register them 
on the camera (M-80).

Loads the personal white 
balance settings, and then 
registers them on the camera 
(M-82).

Allows you to select color matrix 
settings and then register them 
on the camera (M-84).

Allows you to specify JPEG 
quality settings (L, M1, M2, S), 
and register them on the 
camera (M-86).

Applies the settings that you have specified in all the tab 
sheets to the camera and closes the [Camera settings] 
dialog box.

Applies the settings that 
you have specified in the 
[Shoot settings] tab sheet 
to the camera.

Restores the parameters to their original ones 
and closes the [Camera settings] dialog box.
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You can select tone curves, specify the sharpness and contrast, and then register up to three 

sets of these settings on the camera as processing parameters.

 For more information on setting the processing parameters on the camera, refer to “Setting 

the Processing Parameters” in the camera’s Instruction Manual.

1 Click the [Parameters] button (M-77).

 The [Parameters settings] dialog 

box appears.

2 Select the [Set 1], [Set 2], or [Set 3] tab.

3 Specify the tone curve, sharpness, and contrast.

Specifying the Parameters

[Standard]:
The standard tone curve is set.

[TCD 1] through [TCD 3]:
The tone curve that has been 
selected in “Specifying the 
Tone Curve” (M-80) is set.

Drag the slider left or right to specify the sharpness.
Higher values give higher levels of edge sharpening.

Drag the slider left or right to specify the contrast.
Higher values give higher levels of contrast.



Shot Settings

M-79

M

4

S
p

e
c
if
y
in

g
 C

a
m

e
ra

 S
e

tt
in

g
s
 i
n

 E
O

S
 V

ie
w

e
r 

U
ti
lit

y

4 Click the [Apply to camera] button.

 The [Confirm settings] dialog box appears.

5 Check the settings and click the [Apply to camera] button.

 The parameter is registered on the 

camera.

6 Click the [Close] button.

 The [Parameters settings] dialog box closes.
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You can download saved tone curves from a computer and register up to three (M-39) as tone 

curve data on the camera. You can also select the tone curve data that has been loaded into 

the [TCD 1] through [TCD 3] tab sheets, from the list box shown in “Specifying the Parameters” 

(M-78).

 For more information on registering the tone curve data ([TCD 1] through [TCD 3]) on the 

camera, refer to “Setting the Processing Parameters” in the camera’s Instruction Manual.

1 Click the [Tone curve] button (M-77).

 The [Tone curve settings] dialog 

box appears.

2 Select the [TCD 1], [TCD 2] or [TCD 3] tab.

3 Click the [Open] button.

 The [Open] dialog box appears.

4 Open the folder containing the tone curve, select a file, and then 

click the [Open] button.

 The tone curve is loaded.

Specifying the Tone Curve
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5 Select a channel from the list box.

6 Click the [Apply to camera] button.

 The tone curve is registered on the camera.

7 Click the [Close] button.

 The [Tone curve settings] dialog box closes.
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You can download saved white balance data from a computer and register up to three (M-36) 

as personal white balance on the camera.

 When you upload a personal white balance setting to the camera, <  > to <  > 

is displayed on the panel located on the back of the camera.

 For more information on setting the personal white balance on the camera, refer to 

“Selecting the White Balance” in the camera’s Instruction Manual.

1 Click the [Personal white balance] button (M-77).

 The [Personal white balance 

settings] dialog box appears.

2 Select the PC (Personal White Balance) to be registered from the 

list.

Specifying the Personal White Balance
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3 Click the [Open] button.

 The [Open] dialog box appears.

4 Open the folder containing the saved white balance, select the 

file, and then click the [Open] button.

 The white balance is loaded.

5 Enter a title in the [Title] input box.

6 Click the [Apply to camera] button.

 The white balance is registered on the camera.

 To register another setting, repeat steps 2 to 6. You can register up to 3 settings (PC-

1, PC-2 and PC-3).

 To delete a registered setting, select the PC (Personal White Balance) from the list 

and click the [Delete from camera] button.

7 Click the [Close] button.

 The [Personal white balance settings] dialog box closes.

Enter a title for the personal white balance 
to be registered.

Displays the setting status for the PC (Personal White Balance) 
registered on the camera along with their titles.

Registers the selected PC 
(Personal White Balance) settings 
on the camera. Deletes the selected PC (Personal White Balance) 

from the camera.
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You can specify the color space, color saturation, and color tone, and then register up to two 

sets of these settings on the camera. You can also select the predetermined color matrix from 

the list box, which helps you to specify the settings.

 For more information on setting the color matrix on the camera, refer to “Selecting the Color 

Matrix” in the camera’s Instruction Manual.

1 Click the [Color matrix] button (M-77).

 The [Color matrix settings] dialog 

box appears.

2 Select [CM set1] or [CM set2] from the list box.

 This activates the [Color space], 

[Saturation], and [Color tone] list 

boxes.

 If you select any color matrix 

setting other than [CM set1] or 

[CM set2], you cannot register the 

settings on the camera.

Specifying the Color Matrix
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3 Select desired settings from the list boxes.

4 Click the [Apply to camera] button.

 The color matrix is registered on the camera.

5 Click the [Close] button.

 The [Color matrix settings] dialog box closes.
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You can specify the JPEG quality for each of the sizes, L (Large), M1 (Middle 1), M2 (Middle 2), 

and S (Small), and then register the settings on the camera.

 For more information on setting the JPEG quality on the camera, refer to “Setting the Image-

recording Quality” in the camera’s Instruction Manual.

1 Click the [JPEG quality] button (M-77).

 The [JPEG quality settings] dialog 

box appears.

2 Drag the slider left or right to adjust the JPEG quality.

 Higher values give a lower compression ratio and higher image quality for any size.

3 Click the [Apply to camera] button.

 The JPEG quality is registered on the camera.

4 Click the [Close] button.

 The [JPEG quality settings] dialog box closes.

Specifying the JPEG Quality
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Remote Shooting in 

EOS Viewer Utility

This chapter describes how to use the Remote Shooting function in EOS 

Viewer Utility for taking shots and specifying the camera settings remotely 

from your computer.

For more information on the restrictions of remote shooting, refer also to the source 

listed below.

Readme: Double-click the [Canon Utilities] folder � the [EOS Viewer Utility] folder 

� [EOSUtility] � [ReadMe].

Starting the Remote Shooting Function...............................................M-88

Remote Shooting ....................................................................................M-90

Single-frame Shooting .........................................................................M-90

Timer Shooting ....................................................................................M-91

Interval Timer Shooting .......................................................................M-92

Specifying the Camera Settings............................................................M-93

Specifying the Save Destination..........................................................M-93

Camera Settings..................................................................................M-94

Processing Parameters .......................................................................M-96
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Starting the Remote Shooting Function

1 Connect the camera to your computer (M-8).

2 Start up EOS Viewer Utility (M-12).

3 Select the folder to save the 

image in. 

 Select a folder in the Tree View 

Area to save the image in, or 

create a new folder (M-16). (The 

[Capture] folder is created here as 

an example.)
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4 Select the [Option] menu � [EOS Capture].

 The EOS Capture main window appears.

EOS Capture main window

 For OS X, to quit the Remote Shooting function, select the [EOS Capture] menu �

[Quit EOS Capture].

 For OS 9, to quit the Remote Shooting function, select the [File] menu � [Quit].

EOS Capture is one of the functions of EOS Viewer Utility. Therefore, when you quit 

EOS Viewer Utility, EOS Capture also quits.

5 Click the [Release] button to take a shot (M-90).

Allows you to check and specify 
the camera settings (M-94).

Release button (M-90)

 button (M-96)

Shows/hides the set processing 
parameters dialog box.

Status

Displays the status while 
specifying the settings.
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Remote Shooting
You can control the camera from your computer and take single-frame shots, timer shots and 

interval timer shots. The images are automatically saved on your computer.

Before you use the Remote Shooting function, be sure to check that the camera is 

ready for shooting. If the camera is not ready for shooting (the lens is not attached, 

etc.), you cannot perform the operation as shown below.

1 Set the camera up ready to shoot.

2 Make various settings.

 See “Camera Settings” (M-94) and “Processing Parameters” (M-96) for information 

on how to specify the camera settings.

 See “Specifying the Save Destination” (M-93) for information on how to specify the 

settings for saving images.

3 Click the [Release] button.

 The shot images are displayed in 

EOS Viewer Utility and saved in 

your computer automatically.

Pressing the space bar allows you to shoot.

Single-frame Shooting
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Approximate Transfer Times for Shooting RAW Images

• The transfer times given here are only approximations. Actual transfer times vary 

widely depending on the images and the computer system.

• The times for images shot in JPEG format will be shorter than those shown above.

• Transfer times are based on Canon testing standards.

(Time until images appear in the EOS Viewer Utility main window after you uncheck the 

[Save also on the camera’s memory card] checkbox and click the [Release] button in the 

EOS Capture main window using the following: OS: OS X; CPU: Power PC G4 700 MHz; 

RAM: 256 MB)

When the camera is set to One Shot AF, you cannot take shots if the camera cannot 

focus. 

If you cannot take shots with the auto focusing, focus manually and then take a shot.

The number of available shots changes depending on the available capacity on your 

computer’s hard disk. You can check the number of available shots with the [Shots to 

Go] (M-94).

1 Select the [Tool] menu � [Timer shooting].

 The [Timer shooting settings] dialog box appears.

2 Enter a delay time and click the [Start] button.

 You can set a value between 0 

seconds and 99 minutes 59 

seconds in 1-second increments.

 Timer shooting shots are taken.

Transfer Time Approx. 12 sec.

Timer Shooting
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1 Select the [Tool] menu � [Timer shooting].

 The [Timer shooting settings] dialog box appears.

2 Click the [Interval timer shooting] checkbox.

3 Enter the shooting interval and the number of shots. Then click 

the [Start] button.

 You can set a shooting interval 

between 5 seconds and 99 

minutes 59 seconds in 1-second 

increments.

 You can set up to a maximum of 

1999 shots.

 Interval timer shooting is 

performed using the specified 

interval between shots and the 

specified number of shots.

On some types of computers, if you set a short interval between shots and there is 

insufficient time to download and save the images, it may not be possible to take shots at 

the specified interval. If this occurs, set a longer interval between shots and take the 

shots again.

Interval Timer Shooting
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Specifying the Camera Settings
You can check and change the settings in the camera from your computer remotely.

You can specify save destination files and file names.

Before you specify the settings, be sure to check that the camera is ready for shooting. If 

the camera is not ready for shooting (the lens is not attached, etc.), you cannot make 

some of the settings.

1 Select the [File] menu ���� [Save destination setting].

 The [Save settings] dialog box appears.

2 Specify desired settings and click the [OK] button.

Save settings dialog box

Specifying the Save Destination

Allows you to change the destination folder to which images will 
be saved. The name of the destination folder is displayed next 
to the [Browse] button.

Applies the settings and closes the [Save settings] 
dialog box.

Cancels all the settings, and restores the settings to 
their original ones.

Clicking the checkbox saves images 
on the memory card in the camera.

Use this field to enter a file name when 
saving an image. The file name can 
consist of up to 18 characters.

Enter a sequential number with a range of 
0000 to 9999 that is added to the end of 
the file name.
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You can check and specify the camera settings.

1 Check the camera settings.

‘

* The above window shows all the information at once. In actual use, only the 

information needed is displayed.

Camera Settings

Shooting mode
Displays/specifies the 
shooting mode.

White Balance

Displays/specifies the 
white balance.

Exposure compensation

Displays/specifies the exposure 
compensation value.

Image recording quality
Displays/specifies the 
image recording quality.

ISO Speed

Displays/specifies the ISO 
speed.

Aperture value
Displays/specifies Av (aperture value).
(not displayed when Shutter-priority AE or 
Program AE is specified for the shooting mode)

Shutter speed

Displays/specifies Tv (shutter speed).
(not displayed when Aperture-priority AE or Program 
AE is specified for the shooting mode)

Save destination display
Displays the destination 
folder to which images will 
be saved.
(When you select the [Save 
also on the camera’s 
memory card] checkbox, 
the camera/PC icon is 
displayed, and when you 
deselect the checkbox, the 
PC icon is displayed.)

Color temp.

Specify the color temperature in a range 
of 2800K to 10000K.

Metering mode

Displays/specifies the 
settings of the 
metering mode.

Bracket shots

Displays the settings for 
bracketing shots.
(displayed when any of 
WBB/AEB/ISOB/FEB is 
specified)

AF mode

Displays the settings 
of the AF mode.

Drive mode

Displays the settings of the drive mode.

Warning display

Displayed when the remote shooting is impossible due 
to inappropriate settings.

Battery status

The battery level of the 
camera is indicated by 
[ ] or [ ]. When you 
are using the DC Coupler 
Kit, [ ] is displayed.

Shots to Go
Displays the number of 
available shots.
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2 Click the icon.

 The icon displayed here shows 

exposure compensation as an 

example.

3 Use the button to change a value.

 The changed settings are applied to the camera.

1-step down settings button
Allows you to decrease the value by 1 step.

Minimum settings button

Specifies the minimum value.

1-step up settings button
Allows you to increase the value by 1 step.

Maximum settings button

Specifies the maximum value.
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You can specify the processing parameters displayed in the camera.

 If the set processing parameters dialog box has not appeared, click the [�] button.

Change the settings.

 Use the slider and list box to specify the settings.

 The changed settings are applied to the camera.

Processing Parameters

CC Filter slider

Allows you to correct the white balance using 
the digital color filter for green/magenta hue.

LB Filter slider

Allows you to correct the white balance using 
the digital color filter for blue/amber hue.
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Troubleshooting and

Uninstallation

This chapter provides troubleshooting and describes the software 

uninstallation procedures.

Troubleshooting .....................................................................................M-98

Uninstalling the Software.....................................................................M-100

Index ......................................................................................................M-101
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Troubleshooting
When the “Communication between the camera and computer failed” or “Software not running 

correctly” message appears, check the items described below.

 Does your computer comply with these requirements?

� A Macintosh with a FireWire (IEEE1394) connector as a standard feature.

* Operation is not guaranteed when the camera is connected to a FireWire (IEEE1394) 

interface that is not a standard feature of Macintosh.

 Are the camera and computer connected correctly?

� Connect the camera to your computer correctly using the dedicated cable (M-8).

 Is there sufficient charge left in the camera battery?

� Your computer does not supply power to the camera. Connect the DC Coupler Kit to the 

camera or load a fully charged battery into the camera before connecting it to your 

computer.

 Do you have more than one camera connected to your computer?

If you connect more than one camera to the same computer, the driver and camera may not 

operate normally.

� Quit the software and disconnect all the dedicated cables. Then connect only one 

camera to the same computer again.

I have installed the software but the camera and 
computer cannot communicate.
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 Is the preferences file for the software corrupted?

� The preferences file for your software may be damaged.

Quit all active programs, delete the [Canon CameraCom Pref] file and the preference 

files for the software you are using from the [Preferences] folder, and then restart the 

software.

For OS X, double-click the startup disk � click the [Home] button � the [Library] folder �

[Preferences] to open the [Preferences] folder and delete the target preference files.

For OS 9, double-click the startup disk � the [System Folder] � the [Preferences] folder 

to open the [Preferences] folder and then delete the target preference files.

• Canon CameraCom Pref Communications and default settings file shared by all 

software programs

• CanonEOSViewerUtility Pref Preferences file for EOS Viewer Utility

• PhotoStitch Pref Preferences file for PhotoStitch

The software doesn’t run properly or doesn’t run at all.
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Uninstalling the Software
The following explanation uses the procedures for uninstalling EOS Viewer Utility as an 

example for uninstalling other programs as well.

 The software uninstallation procedure is the same for both OS X and OS 9.

 Before beginning the software uninstallation, quit all programs you are using and disconnect 

the dedicated cable from your computer.

 When you have moved the folders and the software to be deleted to the Trash, select 

[Empty Trash] from the [Finder] menu (For OS 9, select [Empty Trash] from the [Special] 

menu.) and empty the Trash. You cannot reinstall the software until you have emptied the 

Trash.

1 Display the folder in which the software is saved.

 Open the [Canon Utilities] folder.

2 Drag the folder for the software to be uninstalled to the Trash.

3 Select the [Finder] menu on the desktop � [Empty Trash].

 For OS 9, select the [Special] menu � [Empty Trash].

 The image is deleted.

 When you drag the folder to the Trash, take great care not to delete any important 

images at the same time.

 When uninstallation ends, restart your computer.
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